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1 Introduction

The Fabasoft Personnel File provides electronic management of personnel files in a central
location. You can either record the mandatory personal data via the web browser interface or use
the import mechanism. Additionally, you can store documents of a personnel file in a folder
hierarchy of your choice. Dashboards offer a comfortable and quick overview of your personal files.
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2 Getting Started With Your Personnel File

A prerequisite for the use of the personnel file is that the “Personnel File” service package is
activated. In addition, the service packages “Personnel File (Access)” and “Skills Management” are
available as optional extensions.

If you are the organization owner, organization administrator, or personnel file administrator, you
will find topics on setting up and administering the personnel file in chapter 18 “Administration
Tasks".

If you are a personnel file user, see topics about using the personnel file from the next chapter
onwards.

3 Structuring Elements of the Personnel File

The structuring elements of the personnel file are:

e Personnel File (Dashboard)
For end users the dashboard is the access point to the personnel file.

e Personnel File Configuration
In the personnel file configuration common settings, the structure of personnel files and the
personnel file users (licensing) are defined.
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¢ Personnel File Shelf
The personnel file shelf is based on a personnel file configuration, but the defined settings can
be overwritten or extended. The personnel file shelf is used to manage the personnel files and
to specify the access rights.

e Personnel File
A personnel file is assigned to a person who is standing in an upright employment relationship
with the company or will be or was in such an employment relationship. Besides the possibility
to enter metadata, documents can be stored.

e Personnel File Folder
Personnel file folders are used for structuring personnel files. Besides the predefined folders
that are defined in the personnel file configuration or personnel file shelf, additional personnel
file folders can be created ad hoc.

¢ Business Case Shelf
In a business case shelf, business cases and documents are managed, which are not assigned
to a single personnel file. Bulk documents can be used to generate and store individual
documents for each personnel file.

e Personnel File Collection
A personnel file collection can be created in a Teamroom and can be used to collect personnel
files that are relevant for the user.

4 Personnel Files (Personal Dashboard)

The personnel files dashboard provides the access point to the personnel file for end-users.

When you are added as a personnel file user to a personnel file configuration, a dashboard is
automatically created and placed on “Home". If you are removed as a personnel file user, the
dashboard is removed, too.
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4.1 Dashboard

The personnel file dashboard is divided in following areas:

Recently Used Personnel Files
Shows the personnel files that have been recently used by the user.

Recently Used Documents
Shows the documents that have been recently used by the user.

Inconsistent Personnel Files
Shows inconsistent personnel files if the consistency check is configured.

Active Employees
Shows the number of active employees in the last twelve months.

Entries/Leaves
Shows the number of entries and leaves in the last twelve months.

Turnover
Shows the turnover of staff in the last twelve months (SchlUter formula).

Anniversaries

Shows employees with anniversaries in the near future.
Birthdays

Shows employees with birthdays in the near future.

Reports
Shows the generated PDF reports.

Organizational Structure
Shows the organizational structure that can be used to assign personnel files to positions.

Personnel File Shelves
Shows the personnel file shelves that are used to manage the personnel files.

Business Case Shelves
Shows the business case shelves that are used to manage the business cases.

Note: The statistics are only available, if the setting Calculate Statistics of the personnel file shelf is
activated. By default, the data is updated once a day. With the “Update Statistics” context menu
command of the personnel file shelf the data can be updated manually.

4.2 Actions

You can execute following actions:

Create Personnel File
With the “Create Personnel File” action you can create new personnel files. For more
information, see chapter 6.1 “Create Personnel File".

Import Personnel Files
With the “Import Personnel File” action you can import or update personnel files using a CSV
file. For more information, see chapter 6.2 “Import Personnel File".

Register Documents

With the “Assign Documents” action you can register documents (which are already in the
system) to personnel files using a CSV file. For more information, see chapter 8.15 “Registering
Documents Automatically”.

Fabasoft Personnel File
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e Create Report
With the “Create Report” action you can create PDF reports about the personnel files of a
personnel file shelf. For more information, see chapter 6.3 “Create Report”.

¢ Switch to Configuration
With the “Switch to Configuration” action you can open the personnel file configuration.

e Settings
With the “Settings” action you can define common properties of the personnel files dashboard
like the logo or notification setting.

5 Personnel File Shelf

The personnel file shelf is used for the management of personnel files and predefines the folder
structure of personnel files.
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5.1 Dashboard

e Personnel Files
Shows the active and inactive personnel files of the personnel file shelf. Active means that an
upright employment relationship with the company exists. Inactive means that the entry date is
in the future (predefined personnel files) or the separation date is in the past.

e Inconsistent Personnel Files
Shows inconsistent personnel files if the consistency check is configured.

o Active Employees
Shows the number of active employees in the last twelve months.

e Entries/Leaves
Shows the number of entries and leaves in the last twelve months.
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e Turnover
Shows the turnover of staff in the last twelve months (Schliter formula).

e Anniversaries
Shows employees with anniversaries in the near future.

e Birthdays
Shows employees with birthdays in the near future.

e Scan Queue (only visible if at least one pre-captured document exists)
Shows the pre-captured documents in which no scanned content has been uploaded.
Note: Your system administrator has to configure the scanner software accordingly such that
the documents can be imported via a web service.

e Reports
Shows the generated PDF reports of the personnel file shelf.

o (Closed Personnel Files
Shows the closed personnel files of the personnel file shelf. Closed personnel files cannot be
changed.

e Canceled Personnel Files
Shows the canceled personnel files of the personnel file shelf.
Note: Canceled personnel files can be permanently deleted by users with “Full Control”, if no
retention rules are violated.

o Thesauri
Shows the thesauri in which terms for tagging of documents can be managed. At least one
thesaurus has to be created in the personnel file configuration or personnel file shelf so that
the tagging can be used. The default thesaurus for new terms is defined in the settings of the
personnel file configuration or personnel file shelf. Thus, new terms can be created directly in
the tagging process. If no standard thesaurus is specified, only the predefined terms in the
thesauri can be used. The default thesaurus of the personnel file shelf is preferred to the
default thesaurus of the personnel file configuration.

Note: The statistics are only available, if the setting Calculate Statistics of the personnel file shelf is
activated. By default, the data is updated once a day. With the “Update Statistics” context menu
command of the personnel file shelf the data can be updated manually.

5.2 Actions

You can execute following actions:

o Create Personnel File
With the “Create Personnel File” action you can create new personnel files. For more
information, see chapter 6.1 “Create Personnel File".

e Import Personnel Files
With the “Import Personnel File” action you can import or update personnel files using a CSV
file. For more information, see chapter 6.2 “Import Personnel File".

e Register Documents
With the “Register Documents” action you can register documents (which are already in the
system) to personnel files using a CSV file. For more information, see chapter 8.15 “Registering
Documents Automatically”.
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e Create Report
With the “Create Report” action you can create PDF reports about the personnel files of a
personnel file shelf. For more information, see chapter 6.3 “Create Report”.

e Settings
With the “Settings” action you can change the settings of the personnel file shelf. For more
information, see chapter 18.3 “Personnel File Shelf”.

e Team
With the “Team” action you can define access rights for the personnel file shelf. For more
information, see chapter 16.1 “Authorize Team (Personnel File Shelf)".

6 Personnel File

A personnel file is assigned to a person who is standing in an upright employment relationship with
the company or will be or was in such an employment relationship.

00000001 - Yang, Aaron (Personnel File): Edit Support

Master Data

Master Data

Contact Data

Herr

skills - Aaron Yang, MSc
Neue Weide 23

2191 NASSFELD
GSTERREICH

Access
General

Remarks
Edit Remove

Versions

Personnel Number * State

M d Externall
Retention 00000001 Active +/ Managed Externally

Security Surname * First Name
Yang Aaron

Title Post Title
M5c

Calutatinn

Besides the possibility to enter metadata, documents can be stored in a personnel file. In a
personnel file, an overview of all documents of the personnel file is displayed on top-level. The tree
view can be used to navigate in the several personnel file folders.

Personnel files, personnel file folders and documents are filtered, if the user has no access rights.

6.1 Create Personnel File

To create a personnel file, perform the following steps:
1. Navigate in the personnel file dashboard or in the desired personnel file shelf.
Click the “Create Personnel File” action.

If you are in the personnel file dashboard and several personnel file shelves exist, select the
desired personnel file shelf.
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4. Enter the data on the “Master Data”, “Contact Data” and “Access” tab. At least the surname has
to be specified.

o If the personnel number is not generated automatically, you have to enter it manually. When
using the manual assignment you can also enter additional personnel numbers.

o On the “Access” tab, in the Assigned User field you can enter a user who corresponds with the
personnel file and should get read access.
In the Supervisors field, you can enter users/organizations that should get read access to all
personnel files of their subordinates.
Note: If it is configured that users are taken over from the organizational structure the fields
are displayed read-only.

5. Click “Next".

More information about accessing personnel files as employee or supervisor can be found in
chapter 16.3 “Personnel File”.

Note: Personnel files can only be created if a Folder Structure for Personnel Files is defined in the
personnel file configuration.

6.2 Import Personnel Files

Personnel files can be imported and updated using a CSV file.
To import personnel files, perform the following steps:

1. Navigate in the personnel file dashboard or in the desired personnel file shelf.
2. Click the “Import Personnel Files” action.

Optionally, click the “Download CSV Template” button to retrieve a template that describes the
necessary data structure.

4. Enter the path to the CSV file in the Content field.
5. Click “Start Import".
6. After the import has finished, click “Next".

The personnel files are stored in the personnel file shelf.
Note:

¢ For the personnel file import, a manual assignment of personnel numbers is required (settings
of the personnel file shelf > “Numbering” tab > Generate Personnel Number Automatically > “No”").

e To prevent that fields (that should be updated by an import) are changed directly in the
personnel file using the user environment, it is possible to set the corresponding fields read-
only via the personnel file configuration or personnel file shelf on the “General Settings” tab, in
the Externally Managed Master File Data field. This applies only to personnel files for which the
“Managed Externally” option is enabled.

e Incase of an error in a personnel file, the lines concerning the same personnel number are
ignored.

The CSV columns are in general free-text fields of type string, number or date (yyyy-mm-dd). The
Fabasoft Cloud ID can be found on the “General” tab of the corresponding object. The import ID
can be used to update objects and assign these objects to other objects. Following CSV columns
are available:
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CSV Column Field Possible Value

PersNum Personnel Number String

FileShelfId Personnel File Shelf Fabasoft Cloud ID or Import ID (has
to be specified if the import is
carried out not in context of a
personnel file shelf)

Surname Surname String

FirstName First Name String

Sex Sex 1, 2 or 103 (male, female or diverse)

Title Title String

PostTitle Post Title String

CommLanguage Language for Communication Reference of a system language
(e.g. LANG_GERMAN, LANG_ENGLISH)

Salutation Salutation String

Birthday Date of Birth Date

SocialSecld Social Security Number String

PreviousNames All Previous Names String

ImageTeamroom Teamroom that contains employee |Fabasoft Cloud ID of a Teamroom

photo

ImageName Photo Object name of an image

EntryDate Entry Date Date

SeparationDate Separation Date Date

Birthplace Birthplace String

Nationality Nationality String

Denomination Denomination String

Company Company (Textual) String

Orgunit Organizational Unit (Textual) String

Street Address (Street) String
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ZipCode Address (Zip Code) String

City Address (City) String

State Address (State) String

Country Address (Country) String

AddrTopic Address (Topic) Reference of a topic (e.g.

TermBusiness, TermPrivate)

Emaill E-Mail Address (Topic: E-Mail 1) String

Email2 E-Mail Address (Topic: E-Mail 2) String

Email3 E-Mail Address (Topic: E-Mail 3) String

Phone Telephone Numbers (Topic: String

Business)

Fax Telephone Numbers (Topic: Fax) String

Mobile Telephone Numbers (Topic: Mobile) |String

PrivatePhone Telephone Numbers (Topic: Private) |String

BankAccountHolder |Account Holder String

Iban IBAN String

Bic BIC String

Qualification Qualification Import ID of the qualification (skills

management)

QualificationLevel || evel Import ID of the rating scale value

of the qualification (skills

management)

RoleDescription Role Descriptions Import ID of the role description
(skills management)

FullTimeEquivalent | py||-Time Equivalent (in Percent) Number

Userld Assigned User Log-in name of the user (user
object)

SupervisorId Direct Supervisor E-mail address or Fabasoft Cloud ID

of the user (user object)
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AllSupervisorIds

Supervisors

E-mail addresses or Fabasoft Cloud
ID of the users (separated by “|")

AdditionalPersNums

Additional Personnel Numbers

String

Remark

Remark

String

GrossIncomeSymbol

Gross Income (currency)

String (e.g. EUR, USD)

GrossIncomevValue Gross Income (value) Number
OverrideKeys - CSV columns of properties to be
overwritten separated by commas
(otherwise empty values are
ignored and values are added in list
properties)
Note:

¢ To populate fields that can consist of several rows (e.g. Address), it is possible to specify several
rows in the CSV file with the same personnel number (PersNum). If the Fileshelf1d is used, it
has to be specified for each line.

o Ifitis defined in the personnel file configuration that unique personnel numbers should be
used across all personnel file shelves, existing personnel files (persnum) can be moved by

specifying a different Fileshelf1d.

If a user-defined form is assigned to personnel files, these properties can also be imported (the
programming name of the respective property serves as the column caption).

If several rows with the same personnel number (persnum) but different personnel file shelves
(Fileshelf1d) exist, a primary personnel file shelf is determined as described below. All rows
that do not correspond to this primary personnel file shelf are ignored.

o The lines with an active employment relationship are preferred.

o Inthe case of several active or inactive employment relationships, the line with the most
recent entry date is preferred.

o Rows without an entry date are considered older than rows with an entry date.

o Ifthere are several rows without an entry date, the first row found is used.

6.3 Create Report

To generate a PDF report about the personnel files of a personnel file shelf, perform the following
steps:

1.

Navigate in the personnel file dashboard or in the desired personnel file shelf.
Click the “Create Report” action.

If you are in the personnel file dashboard and several personnel file shelves exist, select the
desired personnel file shelf.

Click the desired report template.
Note: Only report templates are available that are defined in the personnel file configuration.

Fabasoft Personnel File 16



The PDF report is opened and additionally stored in the personnel file shelf in the Generated Reports
field.

6.4 Upload

With the “Upload” action, you can store files in the personnel file shelf. For more information, see
chapter 8.7 “Uploading a Document”.

6.5 Scan

With the “Scan” action, you can scan documents and directly store them in the personnel file shelf.
For more information, see chapter 8.5 “Scanning a Document”.

6.6 Pre-Capture

With the “Pre-Capture” action, you can pre-capture documents for an automatic scan. For more
information, see chapter 8.6 “Pre-Capturing a Document for a Scan”.

6.7 Create Personnel File Folder

If it is defined in the personnel file configuration or in the personnel file shelf that personnel file
folders may be created on top-level, you can add personnel file folders with the “Create Personnel
File Folder” context menu command. For more information, see chapter 7.1 “Creating a Personnel
File Folder”.

6.8 Show New Events

In order to be able to follow changes over time of personnel files, an own overview of the history is
available that can be viewed from different angles.

To view events, perform the following steps:

1. Navigate to the desired personnel file.

2. Click the “Show New Events” action.

An overview of the recent events is displayed. The “Timeline” tab visualizes the time course; the
“History” provides a textual overview. The other tabs represent different groupings.

Notifications about new events
Notifications can be displayed in the welcome screen or can be subscribed via e-mail.
To define notification settings, perform the following steps:

1. Inthe user menu click “Notifications”.
2. Click the “Settings” button.

Choose about which changes and how you want to be notified. For the personnel file an own
area is provided.

4. Click “Save”.

6.9 Properties

To edit a personnel file, perform the following steps:

Fabasoft Personnel File 17



1. Navigate to the desired personnel file.
2. Click the “Properties” action.
3. Enter the desired data and click “Next".

Note: To access the documents of a personnel file, click on the personnel file or execute the
“Open” context menu command.

Besides the usual master and contact data of an employee, you can also specify the following:
“Master Data” tab

e Managed Externally
To prevent that fields (that should be updated by an import or via the SAP integration) are
changed directly in the personnel file using the web environment, it is possible to set the
corresponding fields read-only. The affected fields are defined in the personnel file
configuration or shelf.

“Access” tab

o Assigned User
In this field, you can enter the employee to whom the personnel file is assigned. This allows
viewing the documents intended for employees.

o Direct Supervisor
In this field, you can specify the direct supervisor. This allows viewing the documents intended
for supervisors.

e Supervisors
In this field, you can specify all higher-level supervisors in the hierarchy. This allows viewing the
documents intended for supervisors.

Note: If it is configured that users are taken over from the organizational structure the fields are
displayed read-only.

More information can be found in chapter 11 “Personnel File Access” and 16.3 “Personnel File".

6.10 View as PDF

For metadata of a personnel file and associated documents, a PDF overview can be generated. If a
watermark is defined in the personnel file configuration or personnel file shelf, the watermark is
added to the document.

To view the personnel file as PDF, perform the following steps:

1. Navigate to the desired personnel file.

2. On the context menu of the personnel file, click “View as PDF".
The generated PDF document will be opened automatically.

Note: With the “View List of Contents” context menu command, you can generate a PDF overview
without the document contents.

6.11 Closing a Personnel File

Personnel files with a defined separation date can be closed. When closing a personnel file also the
assigned documents are closed. After closing, no further changes are possible. However, canceled
documents can still be deleted.
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For retention-worth documents, the retention period is calculated and applied on the basis of the
retention rule defined in the category. The retention period cannot be shortened anymore.

To close a personnel file, perform the following steps:

1. Navigate to the desired personnel file.

2. On the context menu of the personnel file, click “Advanced” > “Close”.
3. Click "Next" to display the overview of the personnel file.
4

Before closing, you can clean up the personnel file and deal with unwanted documents on the
“Documents” and “Canceled Documents” tabs.

5. Click "Close".
Note: If the document contains canceled documents with a category that defines a retention
worthiness, a corresponding message is displayed. Click on “Remove Categories and Close” to
remove the categories because no retention period can be applied to canceled documents.

The closed personnel file is stored in the “Closed Personnel File” field. The state “Closed” can be
removed again using the “Advanced” > “Remove ‘Closed’ state” context menu command. This allows
the personnel data to be changed again. The additional operations carried out during the closing,
such as the closing of documents or the calculation of the retention period cannot be reversed.

Activity “Close File”

You also have the option to start a process for closing a personal file. To do this, execute the
context menu command “Tools” > “Start New Process” on the personnel file and select the “Close
File” entry in the “Prescribed Activity” field. The selected process participant has the possibility to
close or not close the personnel file.

6.12 Canceling a Personnel File

Personnel files can only be removed from the personnel file shelf with the “Cancel Personnel File”
command.

To cancel a personnel file, perform the following steps:

1. Navigate to the desired personnel file.

2. Onthe context menu of the personnel file, click “Advanced” > “Cancel”.

3. Click “Yes" to confirm the cancellation.

The canceled personnel file is stored in the “Canceled Personnel File” field. Canceled personnel files
can be restored using the “Advanced” > “Restore” context menu command. Users with “Full Control”
can also delete personnel files permanently (“Delete” command and removing from the
wastebasket), if no retention rules are violated.

6.13 Changing the Assignment of a Personnel File

Personnel files can be moved from one personnel file shelf to another. Depending on the settings
of the current personnel file shelf a copy of the personnel file is kept in the current personnel file
shelf.

To change the assignment of a personnel file, perform the following steps:

1. Navigate to the desired personnel file.

2. On the context menu of the personnel file, click “Advanced” > “Change Assignment”.
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3. Select the new personnel file shelf and define the personnel number if applicable. If it is
configured that a copy remains in the current personnel file shelf you have to define the
personnel number of the copy, too.

4. Click "Next".

Define the settings which should be updated for the personnel file and click “Next".

6.14 Working With Follow-ups

When using the follow-up functionality an e-mail can be sent to a user at a particular time. The
follow-up may be defined for personnel files and individual documents.

To define a follow-up, perform the following steps:

1. Navigate to the desired object.

2. Onthe context menu of the object, click “Tools” > “Create Follow-Up” or “Manage Follow-Ups”
(at last one follow-up is already defined).

3. If you mark the follow-up as personal (only valid for the "Send e-mail" action), it will not be
visible to other users.

4. Select the Action that should be executed.

o Send E-Mail
Define Recipients for the e-mail. In the Message field, you can specify the e-mail text.

o Start Process
Define the process that should be executed.
Note: The process has to be released for the organization.

5. Define the date of the follow-up. You can either specify an explicit date or let the date be
calculated based on a base date field of the object. In addition, you can define whether the
date should be recalculated if the base date value changes. This is mandatory if the base date
does not yet have a value.

6. Click “Next".

Upon reaching the follow-up date and after processing the automatic task the defined action will
be executed.

6.15 Working With Automatic Follow-ups
If a document needs to be reviewed or renewed after a certain period of time, follow-ups are

offered.

A follow-up can be defined manually via the context menu or the category that is assigned to the
document already defines default follow-ups. For this purpose, in the category, in the Default
Follow-Ups field a corresponding follow-up has to be assigned.

Sending the follow-up is based on the Time Interval and the Base Date. The base date may refer
either to a date field of the document or to a date field of the assigned personnel file.

Note:

e The assigned follow-ups are canceled when removing a category.

o If the default follow-ups of a category are changed, the changes can be propagated to the
documents via the “Update Settings” context meu command of a personnel file shelf.
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6.16 Displaying Master Data of an Employee in SAP

To display the master data of an employee in SAP, perform the following steps:

1. Navigate to the desired personnel file.

2. On the context menu of the personnel file, click “Open SAP Personnel Master Data”.

The master data is displayed in SAP.

6.17 Access Using the File System

Personnel files can be accessed via the WebDAV protocol using the file system. To do so you have
to connect a network drive in your file system browser with following URL:
https://<server>/<vdir>/webdav

Example: https://at.cloud.fabasoft.com/folio/webdav

In the file system operations like adding or removing documents are possible.

7 Personnel File Folder

Personnel file folders are used for structuring personnel files. Besides the predefined folders that
are defined in the personnel file configuration (see chapter 18.2.1 “Dashboard”) additional
personnel file folders can be created manually.

7.1 Creating a Personnel File Folder

To create a personnel file folder, perform the following steps:

1. Navigate in the desired personnel file. You can only create personnel file folders on top-level, if
it is correspondingly configured in the personnel file configuration or personnel file shelf. If
applicable, navigate further to an existing personal file folder to create a new one within this
folder.

2. Open the context menu of the personnel file or personnel file folder in the tree view and click
the “Create Personnel File Folder”.

3. Enter a Name and possibly a Subject.
4. Click “Next".

Predefined personnel file folders differ from manually created personnel file folder by a lock
symbol.

7.2 Editing a Personnel File Folder

To edit a personnel file folder, perform the following steps:

1. Navigate to the desired personnel file folder.
2. On the context menu of the personnel file folder, click “Properties”.
3. Enter the desired data and click “Next".

Following fields are available:

“Personal File Folder” tab
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o Name
The name of the personnel file folder.

o Subject
A description of the personnel file folder.

o Category
The category of the personnel file folder.

e Predefined Folder
Shows whether it is a predefined personnel file folder.

o Personnel File
The personnel file folder is assigned to the personnel file that is shown in this field.

“Available Categories” tab

o Available Categories
The defined categories can be assigned to documents of the personnel file folder. Only
categories can be selected that are allowed in the superordinate hierarchy.

Note: When editing a personnel file folder (template) in the personnel file configuration,
configuration-specific fields are provided (see chapter 18.2.1 “Dashboard”).

7.3 Canceling a Personnel File Folder

Manually defined personnel file folders can be canceled, if they are empty.
To cancel a personnel file folder, perform the following steps:

1. Navigate to the desired personnel file folder.
2. On the context menu of the personnel file folder, click “Advanced” > “Cancel”.
3. Click “Yes” to confirm the cancellation.

Note:

e Canceld personnel file folders can be found in a personnel file (“Properties” action) on the
»Canceled Documents” tab. The tab is only visible if at least one personnel file folder or
document is canceled.

e Canceled personnel file folders can be put into the wastebasket by users who have at least
change rights. Users with full control can permanently delete the documents, if no retention
rules are violated.

8 Documents of a Personnel File

Documents in a personnel file are stored in personnel file folders in a structured way.
For storing documents in a personnel file several possibilities are available:

e Create document

e Scan document

e Pre-capture document

¢ Import document (e.g. drag and drop)

e Register document
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Note: Documents can only be stored in personnel file folders not directly in the personnel file.
However, you can still create document at top-level, because the implicit registration of the
document requires selecting a personnel file folder.

8.1 Processing State

Each document has a processing state:

e |In Progress
Documents that should be changed after creating them (e.g. objective agreements) have to
have the “In Progress” state. The state is visualized by a blue arrow as symbol.

e Closed
The content of a closed document cannot be changed anymore. When closing a document a
final form is generated and a version is stored. Closed documents cannot be set in progress
anymore.

e Replaced
A Document that has been replaced by another document gets the “Replaced” state.

e Canceled
When canceling a document the “Canceled” state is set.

Note: When scanning or uploading a document the state is set to “Closed” by default. If the state
should be “In Progress”, you have to unmark the Close Document field.

State transitions:

New State In Progress Closed Canceled
Old State
In Progress no yes yes
Closed no no yes
Canceled yes (by recovering the | yes (by recovering the yes
old state) old state)

8.2 Personnel File Document

A personnel file document can contain several documents (even of different types). One document
in the personnel file document can be defined as the main document. When editing a personnel
file document, the main document is opened. You can edit the other documents using the
properties of the personnel file document (“Personnel File Document” tab > Documents).

Depending on the Use case, you can use documents (for example, Microsoft Word document) and
personnel file documents in the personnel file environment.

8.3 Creating a Document

To create a document, perform the following steps:

1. Navigate in the desired personnel file or personnel file folder.

2. Open the background context menu by right-clicking in the free area. Then click “New”.
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Select the desired document, enter a name and click “Next".

Register the document to the personnel file by entering the metadata.
Note: If you are in a personnel file folder, it is already preselected.

5. Click “Save".

The document is stored in the personnel file folder and can be edited in the corresponding third-
party product (“Edit” context menu command).

8.4 Editing a Document

To edit a document, perform the following steps:

1. Navigate in the desired document.

2. Onthe context menu of document, click “Edit".

Note: Metadata of personnel files can be inserted as updateable fields in associated Word
documents. The “Property” button is available in Microsoft Word on the “Insert” tab (the Fabasoft
Cloud COM Add-in has to be enabled).

8.5 Scanning a Document

To scan and import a document directly on the device, perform the following steps:

1. Navigate in the desired personnel file or personnel file folder.
2. Click the “Scan” action.

Scan the document.
Note: The scanner software has to be configured such that the scanned document is copied to
the clipboard. If the scanner software does not support this directly, you can define the
program copytoclipboard in the post-processing steps of your scanner software. The
program can be downloaded from the scan dialog.

4, After the document has been copied to the clipboard, click “Yes” to confirm the upload of the
document.

5. Ifyou are at top level in a personnel file, select the desired personnel file folder in which the
document should be stored. Otherwise the current personnel file folder is preselected.

6. Add metadata if desired and click “Save”.

8.6 Pre-Capturing a Document for a Scan

Paper documents can be scanned and assigned automatically to the corresponding personnel file.
The assignment is carried out with a barcode that must be entered in the scan dialog.

To pre-capture a document for a scan, perform the following steps:

1. Navigate in the desired personnel file or personnel file folder.
2. Click the “Pre-Capture” action.

If you are at top level in a personnel file, select the desired personnel file folder in which the
document should be stored. Enter the barcode that resides on the paper document.
Additionally, enter a name for the document.

4. Click “Pre-Capture Document”.
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An empty document is created at once. As soon as the document is scanned the content is taken
over in the document. In the personnel file shelf, in the “Scan Queue” field you can find the
documents to be scanned.

Note:

e The “Pre-Capture” action is only available, if it is activated in the personnel file shelf.

¢ Your system administrator has to configure the scanner software such that the scanned

document is uploaded to Fabasoft Folio via a web service (see chapter 18.4 “Providing the Scan

Functionality”).

8.7 Uploading a Document

To upload a document, perform the following steps:

1. Navigate in the desired personnel file or personnel file folder.

2. You can import files using drag and drop, the shortcuts ctr1 + candctrl + vorthe
“Upload” action.
Note: Depending on the web browser not all possibilities may be available.

3. Enter a name and select a personnel file folder if applicable. You can also enter further
metadata.

4. Click "Save”.

8.8 Defining the Validity of a Document

Documents that need to be renewed recurrently can be provided with a validity deadline.
To define the validity of a document, perform the following steps:

1. Navigate to the desired document.

2. On the context menu of the document, click “Properties”.

3. Onthe “Document” tab you can enter a date in the Valid from and Valid to fields.

4. Click “Next".

Note: If a document is not yet valid or expired, it is indicated with a red exclamation mark.

8.9 Signing a Document

Documents can be manually sighed with signatures like “Approve” or “Release”.
To sign a document, perform the following steps:

1. Navigate to the desired document.
2. On the context menu of the document, click “Tools” > “Manual Signatures”.

3. Entervalues in the fields Signature Type, Remark, Signed on/at and Manually Signed by and click
“Add". In the Manual Signatures field all previous signatures and the currently added signature
are shown.

You can repeat this step to sign the document with further signatures.

4. Click “Next" to apply the signatures.

Note: The signatures can also be viewed in the metadata of the document (“Signatures” tab). The
tab is only visible, if at least one signature exists.

Fabasoft Personnel File

25



8.10 Classifying and Registering a Document

When a Mindbreeze InSpire service is available for automatic classification, metadata is extracted
from the document (if possible) and the registration form is prefilled with this data.

The classification and registration of a document that has not yet been classified and registered
can be done either by means of the “Classifying and Registering” context menu command or by
placing it directly in a personal file or personnel file folder.

Note: The functionality is only available, if the Mindbreeze InSpire Service is configured
correspondingly.

To classify and register a document, perform the following steps:

1. Navigate to the desired document.

2. On the context menu of the document, click “Classify and Register*.
Note: The command is not available if the document is already classified. The category
assigned to the document can also cause that the command is not present. Alternatively, you
can directly copy the document in the desired personnel file folder.

3. If possible, metadata retrieved from the document is prefilled and highlighted in color.

4. Check and, if necessary, add metadata and click “Save”.

8.11 Registering a Document

Documents that are not registered to a personnel file can be registered using the “Register as
Personnel File Document” context menu command. Alternatively, a document can also be directly
copied in a personnel file or personnel file folder.

To register a document, perform the following steps:

1. Navigate to the desired document.

2. On the context menu of the document, click “Register as Personnel File Document”.
Note: The command is not available if the document is already registered. The category
assigned to the document can also cause that the command is not present. Alternatively, you
can directly copy the document in the desired personnel file or personnel file folder.

Select the personnel file and personnel file folder the document should be registered to.

Add metadata if desired and click “Save”.

8.12 Re-registering a Document

Documents that are registered to a wrong personnel file or personnel file folder can be re-
registered.

To re-register a document, perform the following steps:

1. Navigate to the desired document.

2. On the context menu of the document, click “Re-register”.

3. Select the personnel file and personnel file folder the document should be registered to.
4

Add metadata if desired and click “Save”.

The document is removed from the current personnel file folder and stored in the new personnel
file folder.
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8.13 Canceling a Document

A document of a personnel file cannot be deleted directly, but must first be canceled.
To cancel a document, perform the following steps:

1. Navigate to the desired document.
2. On the context menu of the document, click “Cancel Document”.

3. Click “Yes" to confirm the cancelation.
Note:

e Canceld documents can be found in a personnel file ( “Properties” context menu command) on
the ,Canceled Documents” tab. The tab is only visible if at least one document or personnel file
folder is canceled.

¢ Canceled documents can be put into the wastebasket by users who have at least change rights.
Users with full control can permanently delete the documents, if no retention rules are
violated.

8.14 Replacing a Document

A document with state “In Progress” or “Closed” can be replaced with another document. The
replacing document may have a different format (e.g. a Word document can be replaced with a PDF
document).

To replace a document, perform the following steps:

4. Navigate to the desired document.

5. On the context menu of the document, click “Replace” > “Upload”.
Note: Alternatively, you can click “Replace” > “Scan”.

6. Choose a file the document should be replaced with and confirm uploading the file by clicking
nyes”,

7. Add metadata if desired and click “Replace”.

8.15 Registering Documents Automatically

Documents that are already in the system can be registered to personnel files using a CSV file. This
method is useful if many documents should be registered.

To register documents automatically to personnel files, perform the following steps:

1. Import all documents in a Teamroom. The names of the documents have to be unique.
2. Navigate in the personnel file dashboard or in the desired personnel file shelf.

3. Click the “Register Documents” action.
4

Optionally, click the “Download CSV Template” to retrieve a template that describes the
necessary data structure.

5. Enter the path to the CSV file in the Content field.
6. Click “Start Import”.
7. After the import has finished click “Next".

The documents are stored in the corresponding personnel file folders.
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Available CSV columns:

CSV Column Field Possible Value
PersNum Personnel number of the String
personnel file
FileShelfld Personnel File Shelf Fabasoft Cloud ID or Import ID (has
to be specified if the import is
carried out not in context of a
personnel file shelf)
Folder Import ID of the folder that | String
should be used to store the
document
Teamroom Fabasoft Cloud ID of the Fabasoft Cloud ID of a Teamroom
Teamroom that contains the
source documents
Document Import ID or name of the String
document that should be
assigned to the personnel
file
DOSEmER e Name of the document String
(optional, if the name should
be changed)
Category Import ID of the category String
that should be assigned to
the document
ValidFrom Valid from of the document | Date
ValidTo Valid to of the document Date
State Processing State of the String (stateInProgress,
document StateClosed)

Note: The Fabasoft Cloud ID can be found on the “General” tab of the corresponding object. The
import ID can be used to update objects and assign these objects to other objects.

If a user-defined form is assigned to documents, these properties can also be imported (the
programming name of the respective property serves as the column caption).

8.16 Predefining Metadata With PDF Documents

When uploading PDF documents, the keywords of the document can be used to predefine

metadata.

Format: FsC:persnum; fileshelfid; folder;category;validfrom;validto; state;
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Example:

¢ All metadata are predefined:
FSC:00002;C00.1.506.2.2177; PF FOLDER SALARY;PF CAT ZE;2013-05-23;2015-07-
25;PersonnelFileDocumentInProgress;

« Category and Valid to are not predefined:
FSC:00002;C00.1.506.2.2177;PF FOLDER SALARY;;2013-05-
23;;PersonnelFileDocumentInProgress;

9 Business Case Shelf

In a business case shelf, business cases and documents are managed, which are not assigned to a
single personnel file. Bulk documents can be used to generate and store individual documents for
each personnel file.

The access rights of a business case shelf can be defined using the “Team” action. Shelf folders are
available for the hierarchical structuring of a business case shelf.

9.1 Business Case

Documents and bulk documents are managed in a business case.

9.2 Bulk Document

A bulk document can contain several documents (also of different types). One document in the
bulk document can be defined as the main document. In addition, personnel files can be specified
for which personalized personnel file documents can be generated from the bulk document.

Create and Register Personnel File Documents
To use the bulk document functionality, follow these steps:

1. Navigate to the desired business case and create a bulk document.

2. Specify the documents in the bulk document (one as the main document).
Note: In Microsoft Word documents, you can insert fields that allow the document to be
personalized for the relevant personnel file.

3. Define the personnel files (either individual personnel files or an entire shelf) for which a
personnel file document should be generated from the bulk document. The Excluded Personnel
Files field allows excluding a subset of personnel files.

4. The personalized personnel file documents are created using the “Bulk Document” > “Create
Personnel File Documents” context menu command. The generated personnel file documents
can be found in the properties of the bulk document on the “Personnel File Documents” tab.

5. Via the “Bulk Document” > “Register Personnel File Documents” context menu command, the
generated personnel file documents are registered for the corresponding personnel files. You
must specify the personnel file folder in which the personnel file documents are to be stored.
You can also specify additional metadata.

Print Personnel File Documents

If you want to print the documents to obtain a manual signature, perform the following steps as
well.
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1. When carrying out the “Bulk Document” > “Print Personnel File Documents” context menu
command, a single PDF document is generated from all personnel file documents with an
individual QR code for each personnel file document.

2. Print the PDF document and obtain the signatures.

Scan the paper documents with the signatures and place them in an appropriately configured
inbox.
Note: More information about inboxes can be found in chapter 18.6 “Inbox".

4. The action defined in the inbox is used to replace all documents in the corresponding
personnel file document with the scanned document. The QR code is used to identify the
personnel file document.

Start Process for Personnel File Documents

To start a process for personnel file documents, proceed as follows:

1. Execute the “Bulk Document" > “Start Process for Personnel File Documents” context menu
command.

2. Select the personnel file documents for which a process is to be started. You can use the
“Remove” context menu command to remove individual personnel file documents.

Click “Next".

4. Define the process and click the “Start Process"” button.

Remove Canceled and Deleted Personnel File Documents

If personnel file documents have been canceled or deleted, these can be removed from the bulk
document using the “Bulk Document” > “Remove Canceled and Deleted Personnel File Documents”
context menu command. New personnel file documents can then again be created for the
removed personnel file documents.

10 Personnel File Collection

A Personnel File Collection can be created in a Teamroom and can be used to collect personnel
files that are relevant for you. Fill the personnel files collection by adding shortcuts to the desired
personnel files.

11 Personnel File Access

Employees or supervisors can be given access to personnel files. The access can be defined either
permanently or temporarily.

The documents that employees or supervisors are allowed to view are determined by the assigned
access rights.

11.1 Grant Access

The access can be granted the following way:

Permanent Access (Manually Managed in the Personnel File)

If it is configured that permanent access is manually managed in the personnel file, personnel file
users can store the relevant employees or supervisors on the “Access” tab in the personnel file:
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o Assigned User
In this field, you can enter the employee to whom the personnel file is assigned. This allows
viewing the documents intended for employees.

o Direct Supervisor
In this field, you can specify the direct supervisor. This allows viewing the documents intended
for supervisors.

e Supervisors
In this field, you can specify all higher-level supervisors in the hierarchy. This allows viewing the
documents intended for supervisors.

Permanent Access (Taken Over From the Organizational Structure)

If it is configured that permanent access is taken over from the organizational structure, the
employees and/or supervisors are automatically entered in the “Access” tab of the personnel file.

Temporary Access

Personnel file users can grant access to personnel files to employees for a limited time. To do so,
navigate to the desired personnel file and execute the “Advanced” > “Grant Temporary Access”
context menu command.

Following fields are available:

e Permissions
Defines the permissions for temporary access.
Note: The selectable permissions are defined in the personnel file configuration.

e Grant Access for
Access is granted to the specified users.
Note: The users defined in the permissions are preselected.

o Start
Start date for temporary access.

e End
End date for temporary access.

o Enter Remark
The entered remark will be displayed in the remarks of the personnel file.

e Add Attachments
The added attachments will be displayed in the remarks of the personnel file.

In the properties of the personnel file, on the “Access” tab, in the Temporary Access field the granted
accesses are listed. You can also remove entries by selecting the desired rows and executing the
“Remove” context menu command.

Note: Temporary access can also be granted via the “Grant Temporary Access” workflow activity.

11.2 Restrict Access

For employees or supervisors with access, all documents of the personnel files are readable by
default. By means of categories, for which special ACLs are defined, it is possible to control which
documents are not viewable or which documents should be editable.

Further information can be found in chapter 16.3 “Personnel File Access”.
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11.3 Confirm Changes in the Organizational Structure

In general, the organization is not managed by personnel file users. If it is configured that the
permanent access is taken over from the organizational structure, changes regarding the access of
personnel files must therefore be confirmed by personnel file users. These personnel file users are
defined in the personal file configuration or personal file shelf.

You can use the workflow activities “Review Access for Employee” or “Review Access for
Supervisors" to accept the changes.

11.4 Use Cases for Users With Personnel Files Access

As an employee, the personnel files access provides you access to certain metadata and selected
documents in your personnel file (for example, payslips). As a supervisor, you can view the
personnel files of your employees. The following chapters explain how to use the personnel files
access.

11.4.1 Using the Fabasoft Personnel File

All you need to be able to use the Fabasoft Personnel File is a web browser. However, it is
recommended to install the Fabasoft Cloud Client to improve the ease of use. Please ask your
administrator for the access data.

11.4.2 Dashboard

If you have been authorized for personal files access, the “Personnel Files Access” dashboard is
available on “Home". The dashboard is intended for employees and supervisors with personnel files
access and is divided into the following areas:

e My Master Data
Shows the master data of your own personnel file.

o My Personnel File
Shows your own personnel file.

e Uploaded Documents
Shows the documents uploaded by the employee (at least one document must be uploaded).

e Personnel Files With Access
Shows the personnel files of your employees, if you have been granted permanent access.

Note: You can update the list of personnel files using the “Refresh” action, since it is updated only
once a day.

11.4.3 Viewing Metadata

To view the metadata of a personnel file, perform the following steps:

Click the “Personnel Files Access” dashboard.
Click “Personnel Files With Access”.
Click the “Refresh” action, if the desired personnel file is not displayed.

Click the desired personnel file.

A N

Click the “Properties” action.
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6. Click the desired tab to display the corresponding metadata.
Note: Sensitive metadata such as the social security number, gross income or denomination
are not displayed to supervisors.

7. Click “Next".

11.4.4 Viewing Documents

To view the documents of a personnel file that are available to you, perform the following steps:

1. Click the “Personnel Files Access” dashboard.

2. Click “Personnel Files With Access”.

3. Click the “Refresh” action, if the desired personnel file is not displayed.
4

Click the desired personnel file.
The available documents are displayed in a list.

U

Click the desired document to view the preview of the document.

You can use the “Read” action to open the document in the corresponding third-party product.

11.4.5 Uploading Documents

The “Upload” action allows you to upload documents that can subsequently be registered by a
personnel file user.

Note: The “Upload” action is only available if this functionality has been enabled in the
configuration or shelf (Members/Employees Can Upload Documents option).

11.4.6 Using Follow-Ups

You can define follow-ups for personnel files or documents. When the follow-up date is reached, an
e-mail with a link to the personnel file or document is sent to you. You can use this function, for
example, if you want to check a document again in three months.

To define a follow-up, perform the following steps:

1. Navigate in the desired personnel file or document.

2. Click the “Manage Follow-ups” or “Create resubmission” action.

3. Click the “Create Follow-up” button, if you have previously used the “Manage Follow-ups” action.
4

Define the Date of the follow-up.
Note: The Time Span field allows you to conveniently select the date for common time spans.

Ul

You can also enter a Message that should be included in the follow-up e-mail.
Click “Next".

11.4.7 Using the Worklist

The personnel file provides the possibility to perform activities within a workflow. For example, an
activity could be that your payslip has been stored in the personnel file. You can confirm the receipt
and complete the activity by executing the “Noted” work step.

The worklist that is stored as standard on “Home", takes you to your activities. The worklist is
divided into the following areas:
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e ToDo
Contains activities that you still have to process. An activity can consist of one or more work
steps. A mandatory work step (shown in bold) must be carried out before the activity can be
completed. Click on the desired step to perform it.

e Last Finished
Contains the activities you have completed.

e Concerned Objects
Contains objects that are assigned to current activities.

e Tracking
Contains objects that are assigned to completed activities.

12 Skills Management

Skills management allows you to manage job and role descriptions and the assignment of required
qualifications. Acquired qualifications and role descriptions can be assigned to personnel files. Via
the organizational structure personnel files are linked to positions. Job descriptions are assigned to
positions.

The lack of qualifications can be determined from the qualifications required and the qualifications
acquired. In addition position reviews can be performed.

12.1 Dashboard

For skills manager, the skills management dashboard is available, which is divided into the following
areas:

e Job Descriptions
Shows the job descriptions for the organization.

¢ Role Descriptions
Shows the role descriptions for the organization.

o Qualifications
Shows the qualifications that can be assigned as required qualifications to job and role
descriptions as well as positions. The qualifications can also be assigned to personnel files as
acquired qualifications.

e Position Reviews
Shows review procedures of job descriptions, tasks, powers and qualifications for the positions
by supervisors.

e Organizational Structure
Shows the organizational structure for the organization.

e Personnel File Shelves
Shows the personnel file shelves that are used to manage the personnel files.

12.2 Importing Data

If you are in the Skills Management dashboard, you can use the “Import Data” action to import or
update descriptions and qualifications using a CSV file. The "Download CSV Template" button gives
you a template that describes the required data structure.
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The CSV columns are generally free-text fields of the character string type. You can use the import
ID to update objects. The following CSV columns are available:

CSV Column Field Possible Value

Id Import ID String

Class - String (object class;
Qualification, JobDescription,
RoleDescription)

Name Name String

Description Description String

RatingScale Rating Scale String (import ID of the rating

scale; only for qualifications)

TasksPermissions Tasks and Powers String (only for job and role
descriptions)

ReqQualification Qualification (Required String (import ID of the
Quialifications) qualification; only for job and role
descriptions)

ReqQualificationLevel || eve| (Required Qualifications) String (import ID of the rating scale
value of the qualification; only for
job and role descriptions)

To populate fields that can consist of several rows (e.g. Required Qualifications), it is possible to
specify several rows in the CSV file with the same 1d.

12.3 Managing Qualifications
Navigate as a skills manager in the skills management dashboard in the qualifications widget.

Edit Rating Scales

Rating scales are used to quantify qualifications (for example, failed/passed). You can use the “Edit
Rating Scales” action to change, add or delete the predefined rating scales.

The values of a rating scale consist of a name and a percentage of fulfillment (e.g. Failed 0 %,
Passed 100 %).
Define Qualification Categories

A qualification category defines individual qualifications within an area of competence. You can use
this function as demonstrated in the following examples:

e Add qualifications such as “English”, “German”, and “Italian” to the qualification category
“Language Skills” to combine the languages that are relevant to your company.

¢ Add qualifications such as “Java”, “MySQL" and “English” to the qualification category “Junior
Developer” to combine the skills that are relevant for this specific position.
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When selecting qualifications for job descriptions, role descriptions, and organizational structures,
the qualification categories can be selected from a tree view. In the tree view, qualifications without
a category are available via the tree item “Uncategorized Qualifications”.

Create Qualifications

You can use the “Create Qualification” action to define qualifications that can be assigned to job
and role descriptions and positions.

The following fields are available:

e Name
The name of the qualification.

e Description
A more detailed description of the qualification.

e Rating Scale
Defines the appropriate rating scale for the qualification.

e Import ID
If qualifications are managed externally, a unique ID for the import identification can be
defined.

12.4 Managing Job Descriptions
A job description is used to determine the tasks and powers of an employee. In addition, the
qualifications required for the position are defined.

As a skills manager navigate in the skills management dashboard in the job descriptions widget.

Create Job Description
You can use the “Create Job Description” action to define a job description.
The following fields are available:

e Name
The name of the job description.

e Description
A more detailed description of the job description.

e Tasks and Powers
Defines the tasks and powers of an employee with this position.

e Required Qualifications
Defines the necessary qualifications for the position. For the qualifications it can be determined
which degree of fulfillment is at least necessary.

e Import ID
If job descriptions are managed externally, a unique ID for the import identification can be
defined.

12.5 Managing Role Descriptions

A roles description is used to determine the tasks and powers an employee has independent of the
position (e.g. first responder). In addition, the qualifications required for the role are defined.

As a skills manager navigate in the skills management dashboard in the role descriptions widget.
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Create Role Description
You can use the “Create Role Description” action to define a role description.
The following fields are available:

o Name
The name of the role description.

e Description
A more detailed description of the role description.

e Tasks and Powers
Defines the tasks and powers of an employee with this role.

¢ Required Qualifications
Defines the necessary qualifications for the role. For the qualifications it can be determined
which degree of fulfillment is at least necessary.

e Import ID
If role descriptions are managed externally, a unique ID for the import identification can be
defined.

12.6 Managing the Organizational Structure

The organizational structure (organizational units and positions) can be managed by organization
administrators or by organizational members who have been authorized by the “Manage
Organizational Structure” policy. This concerns, for example, the assignment of users to positions.
More information can be found in the “Administration Help Fabasoft Cloud” in the “Manage the
Organizational Structure” chapter.

Information About Changes

If you are in the organizational structure, you can use the “Settings” action to define the users who
are to be informed of changes in the organizational structure by workflow. This enables, for
example, skills managers to assign job descriptions and additional qualifications from deleted
positions to other positions.

Access

The access for employees or supervisors can be taken over from the organizational structure. This
can be defined in the Permanent Access for Employees or Permanent Access for Supervisors fields. The
corresponding fields in the personnel file are displayed read-only.

In addition, a user or a team has to be defined, which should receive activities concerning relevant
changes for the personnel file. This is necessary because the organization can be managed by
users who do not have permissions in the personal files. Via the “Review Access for Employee” and
“Review Access for Supervisors” activities the changes can be accepted.

12.7 Defining Assignments

Once the qualifications, job descriptions, role descriptions and the organizational structure have
been defined, the individual elements can be put in relationship to each other.

Assign a Personnel File to a Position
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As a personnel file user, you are entitled to assign personnel files to positions. To do this, navigate
to the organizational structure in your personnel file dashboard. In the properties of the desired
position you can assign the appropriate personnel file in the Personnel File field. In addition, you can
edit the fields Full-Time Equivalent of the Position (In Percent), Company and Location.

Assign Job Descriptions to a Position

As a skills manager, you are entitled to assign the job descriptions and the additionally required
qualifications to positions. To do this, navigate to the organizational structure in your skills
management dashboard or personnel file dashboard. In the properties of the position you can
enter job descriptions and additional qualifications in the appropriate fields.

Assign Acquired Qualifications and Role Descriptions to a Personnel File
As skills manager you are entitled to enter the acquired qualifications in personnel files.

Navigate in your skills management dashboard in the organizational structure. Open the properties
of the corresponding position. On the “Position” tab, in the Personnel File field, the personnel file is
stored. Open the properties of the personnel file. On the “Qualifications” tab, you can define the
qualifications acquired.

12.8 Showing Missing Quialifications

After the assignments have been carried out, the missing qualifications for the individual
employees can be determined based on the difference between the actual qualifications (defined
in the personnel files) and the target qualifications (defined in the positions).

To do this, navigate as a skills manager in your skills management dashboard and click the “Show
Missing Qualifications” action. If you are in an organizational unit, only positions are considered that
are directly or indirectly subordinate. An overview of the missing qualifications is displayed and it
can be exported as a CSV file.

12.9 Position Reviews

Job descriptions must be regularly reviewed by the skills managers, in co-operation with the
supervisor, with regard to the defined tasks, powers and qualifications.

Skills Manager: Start the Position Review
As a skills manager navigate in your skills management dashboard in the position reviews.

The “Start Position Review” action allows initiating the position review by the head of an
organizational unit for subordinate positions. You have the option of defining a date for the
completion and whether the subordinate organizational units should also be considered. The
heads of the organizational units receive corresponding activities in the worklist.

Head: “Review Job Description” Activity

The heads of the organizational units receive the “Review Job Description” activity for each assigned
position. The “Review" working step allows you to view the current descriptions. In case that
reworking is required, select in the Rework field the “Necessary” entry and enter remarks. With the
“Done” working step, you end the review. In addition, the steps “Define Acquired Qualifications” and
“Request Further Training” are available. When you request further training, a process is started
and the person responsible for further trainings defined in personnel file configuration receives an
activity.
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Note: As skills manager, you can also request further training in the properties of a personnel file
on the “Quialifications2 tab via the “Request Further Training” button.

Skills Manager: Position Reviews

In the skills management dashboard, the position reviews with status are listed under “Position
Reviews".

Status:

e In Progress
Activity is being processed by the head.

¢ Rework Required
The head has completed the review and wishes a rework.

e Done
The head has completed the review and does not wish a rework.
If a rework is necessary, navigate in the appropriate position review:

¢ To change the position, execute the context menu command “Properties” on the position.

e To change a job description, execute the context menu command “Properties” on a job
description.

¢ You can access the role descriptions by executing the context menu command "Properties" on
the personnel file ("Job and Role Description” tab).

After the rework has been completed, you can use the “Close” action to complete the position
review or you can trigger a further check with the “Send to Review” action.

13 Applicant Management

The applicant management enables an efficient, digital management of job applications. Applicant
files, job advertisements, applications, a talent pool and corresponding workflow activities are
available for this purpose.

13.1 Dashboard

Applicant managers can use the applicant management dashboard, which is divided into the
following areas:

e Current Job Applications
Displays the current job applications of the shelves in which you are authorized.

e Current Applicant Files
Displays newly created applicant files and applicant files for which there is at least one current
application.

¢ Talent Pool
Displays the applicant files of the shelves in which you are authorized that have been added to
the talent pool.

e Job Advertisements
Displays the job advertisements of the shelves in which you are authorized.

o Applicant File Shelves
Displays the applicant file shelves in which the applicant files are managed.
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Note: The responsible personnel managers have access to their job advertisements and
applications via the “Personnel File Access” dashboard.

13.2 Applicant Management Shelf

An applicant management shelf is based on a personnel file configuration, but can overwrite the
settings made in it if necessary. The applicant file shelf is used to manage applicant files and define
access rights.

Applicant file shelves can only be created by the personnel file administrator.

Areas

The shelf is divided into the following areas:

Current Job Applications
Displays the current applications of the shelves in which you are authorized.

Current Applicant Files

Displays newly created applicant files or applicant files for which there is at least one current
application.

Talent Pool

Displays the applicant files of the shelves in which you are authorized that have been added to
the talent pool.

Job Advertisements
Displays the job advertisements of the shelves in which you are authorized.

Closed Applicant Files
Displays the closed applicant files.

Settings

“Applicant Management Shelf’ tab

Standard Category for Applicant Files in Talent Pool
Applicant files with commitment to the talent pool get the specified category. This way, for
example, the retention period can be defined. The setting in the configuration is overwritten.

“Default Values" tab

Default Thesaurus for New Terms
If a default thesaurus is specified, new terms can be created directly during tagging.

Default Categories

When an object is created, the specified category is assigned according to the defined object
class. In the Apply to field, you can specify whether the setting applies to instances, templates,
or both.

Default Processes

When an object is created, the specified process is assigned according to the defined object
class or category. In the Apply to field, you can specify whether the setting applies to instances,
templates, or both.

o Additional Default Background Tasks

When an object is created, the specified background tasks are assigned.

Note: The default properties overwrite or extend the settings in the configuration.

Fabasoft Personnel File 40



Access Rights

¢ Full Control
Users with full control can authorize users, manage job applications, applicant files and job
advertisements and edit shelf settings.

¢ Applicant Manager
Applicant managers can manage job applications, applicant files and job advertisements.

13.3 Managing Applicant Files

As an applicant manager, navigate to the current applicant files in the applicant management
dashboard.

The following options are available:

e You can use the “Create Applicant File” action to create an applicant file. You can enter master
data and contact data.

¢ You can assign the applicant file to another shelf using the “Advanced” > “Change Assignment”
context menu command.

e You can merge the applicant file with another file using the “Advanced” > “Merge” context menu
command.

e You can assign a new job application to the applicant file using the “Create Job Application”
action.

e Applicant files can only be deleted if no open job application is assigned.

The “Closed Applicant Files” area is available in the applicant file shelf. Here you will find the
applicant files with no open job application.

13.4 Managing Job Advertisements

As an applicant manager, navigate to the job advertisements in the applicant management
dashboard.

The following options are available:

e You can create a job advertisement using the “Create Job Advertisement” action. You must
specify the responsible personnel manager. If personnel manager is subsequently changed,
the change does not apply to existing job applications based on the job advertisement.

e You can define the state of the job advertisement (“In Process”, “Published”, “Closed”) in the
properties of the job advertisement.

e Job advertisements can only be deleted if all assigned job applications have already been
deleted.

13.5 Managing Job Applications

As an applicant manager, navigate to the current applications in the applicant management
dashboard.

The following options are available:

e You can create a job application using the “Create Job Application” action. You must specify an
applicant file, a job advertisement and the responsible personnel manager.
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¢ You can use the “Switch to Applicant File” action to switch to the assigned applicant file.

e You can use the “Grant Temporary Access” action to define access.

13.6 Managing the Talent Pool

The talent pool stores closed applicant files for which the Commitment for Talent Pool option has
been selected. In this way, applicants for whom no job is currently available can be kept as evident.

13.7 Personnel File Access

The personnel managers have access to the applications and job advertisements that concern
them via the personnel file access dashboard.

The following areas are available:

e Current Job Applications
Displays all open applications for the personnel manager (including temporary access and if
contained in the Other Personnel Managers field).

e Job Advertisements
Displays all job advertisements in which the personnel manager is entered as the responsible
personnel manager.

13.8 Website Integration

Job applications can also be created automatically using the data entered in an HTML form.

To do this, the Enable Website Integration option must be enabled on the “Applicant Management”
tab in the personnel file configuration.

You can provide a corresponding HTML form for applications on your homepage.

<!doctype html>
<html lang="en">
<head>
<meta http-equiv="Content-Type" content="text/html; charset=utf-8" />
<title>Job Application</title>
</head>
<body>

<form name="createobjectform" action="https://at.cloud.fabasoft.com/fsc/createobject"
method="post" accept-charset="UTF-8" enctype="multipart/form-data">

<input name="redirect" value="https://www.example.com/result.html" type="hidden">
<input name="errorredirect" value="https://www.example.com/err.html" type="hidden">

<input name="objectclass" value="FSCPERSONNELFILEQ@L.1001l:ApplicantFile"
type="hidden">

<input name="inbox" value="COO.w.x.y.z" type="hidden">

<input name="jobadvertisement" value="COO.w.x.y.z" type="hidden">
<label for="userfirstname">First Name</label>

<input id="userfirstname" name="userfirstname" value="" type="text">
<br/>

<label for="usersurname">Surname</label>

<input id="usersurname" name="usersurname" value="" type="text">
<br/>

<label for="telephone">Telephone</label>

Fabasoft Personnel File 42



<input id="telephone" name="telephone" value="" type="text">

<br/>

<label for="emailinformation">E-Mail</label>

<input id="emailinformation" name="emailinformation" wvalue="" type="text">

<br/><br/>

<input id="afusetalentpool" name="afusetalentpool" value="true" type="checkbox">

<label for="afusetalentpool">Talent Pool</label>

<br/><br/>

<label for="locationl">Location</label><br/>

<input id="locationl" name="location" value="COO.w.x.y.z" type="checkbox"> Linz<br/>

<input id="location2" name="location" value="COO.w.x.y.z" type="checkbox"> Wien<br/>

<input id="location3" name="location" value="COO.w.x.y.z" type="checkbox"> Bern<br/>

<br/>

<input name="attachmentattrdef" value="FSCPERSONNELFILEQ1.1001:afdocuments"
type="hidden">

<input name="attachmentkeys" value="attachmentl COO.w.x.y.z,attachment2"
type="hidden">

<label for="attachmentl">Cover Letter</label>
<input id="attachmentl" name="attachmentl COO.w.x.y.z" type="file">
<br/>
<label for="attachment2">CV</label>
<input id="attachment2" name="attachment2" type="file">
<br/><br/>
<input value="Send" type="submit">
<input type="reset">

</form>

</body>
</html>

In the example above, the Fabasoft Cloud IDs must be replaced by your concrete values.

® inbox

The Fabasoft Cloud ID of the applicant management shelf.

® jobadvertisement

The Fabasoft Cloud ID of the job advertisement.

e location (Optional)
The Fabasoft Cloud IDs of the locations.

e attachment (Optional)
If the Fabasoft Cloud ID of a category is added with an underscore to the name attribute of a
file, the category will be assigned to the document.

Further information for creating the HTML form can be found here:

https://help.cloud.fabasoft.com/index.php?topic=doc/User-Help-Fabasoft-Cloud-eng/advanced-
use-cases.htm#form-inbox

13.9 Applicant Management Process

The applicant management process begins with the creation of a job application or the receipt of
an application via an inbox.

A simple process flow of an applicant management process can look like this:

1. After creating an application, the applicant manager receives the “Check Job Application” activity
and performs the “Forward to Responsible Personnel Manager” working step.
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2. The personnel manager receives the “Edit Job Application” activity and performs the “Invite
applicant” working step. Thereby appointments can be proposed.

3. The applicant manager receives the “Arrange Appointment” activity and performs the “Send
appointment” working step. The agreed appointment can be communicated via the “Respond
to Personnel Manager” working step.

4. The personnel manager receives the “Appointment Arranged” activity and performs the “Take
Note” working step. The workflow does not continue until the day of the appointment.

5. On the application day, the personnel manager receives the “Conduct Interview” activity and
performs the “Accept” working step.

6. The applicant manager receives the “Accept Applicant” activity and performs the “Send
Acceptance” and “Done” working step.

Activities and Working Steps in Detail

e Check Job Application
o Open

o Send Receipt
Opens an e-mail.

o Check Allocation of Applicant File
Must be executed if a possible duplicate is found.

o Edit Applicant File
Enables you to add master data.

o Forward to Responsible Personnel Manager
The personnel manager receives the “Edit Application” activity.

o Discard
Closes the job application.

o Withdrawn
Closes the job application.

o Reject Without Forwarding to Personnel Manager
The applicant manager receives the “Reject Applicant” activity.

o Edit Job Application
o Open

o Forward Application
The applicant manager receives the “Forward Application” activity.

o Need Further Information
The applicant manager receives the “Need Further Information” activity.

o Invite Applicant
The applicant manager receives the “Arrange Appointment” activity.

o Withdrawn
The applicant manager receives the “Application Withdrawn” activity.

o Reject
The applicant manager receives the “Reject Applicant” activity.

e Forward Job Application
o Open
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(o]

(o]

(o]

Send E-Mail to Applicant
If necessary, the applicant may be asked whether the data may be forwarded to another
personnel manager.

Forward to Personnel Manager
Another personnel manager can be selected.

Withdrawn
Closes the job application.

Need Further Information

(o]

(o]

Open
Send E-Mail to Applicant
Further information may be obtained from the applicant.

Received Information

The information can be forwarded and the personnel manager receives the “Edit
Application” activity.

Withdrawn

The personnel manager receives the “Application Withdrawn” activity.

Reject Applicant

(@]

(@]

Open
Send Rejection to Applicant
The applicant manager can send a rejection e-mail.

Done
Closes the job application.

Forward to Personnel Manager
The job application can be forwarded to another personnel manager.

Withdrawn
Closes the job application.

Arrange Appointment

O

O

Open
Send Appointment

The applicant manager can send an appointment to the applicant by e-mail based on the
proposals made by the personnel manager.

Respond to Personnel Manager

If an appointment has been agreed, the personnel manager receives the “Appointment
Arranged” activity. If no appointment has been made, the personnel manager receives the
“Edit Application” activity.

Withdrawn

The personnel manager receives the “Application Withdrawn” activity.

Appointment Arranged

(0]

(0]

Open

Taken Note
The personnel manager takes note of the agreed date. The workflow continues on the day of
the appointment.
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Withdrawn
The applicant manager receives the “Application Withdrawn" activity.

Reject
The applicant manager receives the “Reject Applicant” activity.

e Conduct Interview

(o]

(o]

Open
Another Interview Needed
The applicant manager receives the “Arrange Appointment” activity.

Withdrawn
The applicant manager receives the “Application Withdrawn" activity.

Accept
The applicant manager receives the “Accept Applicant” activity.
Reject
The applicant manager receives the “Reject Applicant” activity.

e Accept Applicant

O

O

Open

Send Acceptance
The applicant manager can send a acceptance e-mail.

Forward Acceptance

The applicant manager can inform other users of the acceptance. These users receive the

“Accepted Applicant" activity.

Done
Closes the job application.

Withdrawn
The personnel manager receives the “Application Withdrawn” activity.

e Accepted Applicant

O

O

O

Open

Transfer Documents to Personnel File

Users who are allowed to manage personnel files can transfer the applicant file to a

personnel file (new or existing).

Take Note
Closes the job application.

e Application Withdrawn

o

o

Open

Take Note
Closes the job application.

14 Time Tracking

Time tracking allows employees to record their working hours. The payroll department can define
working time models and conditions and thus use the working times recorded by employees for

payroll.

Fabasoft Personnel File
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14.1 Dashboard

The time tracking dashboard is available to users who are entered in the “Time Tracking” role in the
personnel file configuration and are either personnel file administrators or have change access in
at least one personnel file shelf.

The dashboard is divided into the following areas:

Recently Used Personnel Files
Shows the personnel files last used by the user.

Personnel File Shelves
Personnel file shelves are used to manage personnel files and to define access rights. For more
information, see chapter 18.3 “Personnel File Shelf".

Working Time Models
Shows the defined working time models.

Salary Agreements
Shows the defined salary agreements.

Note: Time recording for employees is done via the “Personnel File Access” dashboard.

Actions

You can perform the following actions:

Create Working Time Model
As a personnel file administrator, you can create new working time models using the “Create
Working Time Model” action. For more information, see chapter 14.2 “Working Time Models".

Create Salary Agreement
As a personnel file administrator, you can use the “Create Salary Agreement” action to create
salary agreements. For more information, see chapter 14.3 “Salary Agreement”.

Switch to Configuration
You can use the “Switch to Configuration” action to display the personnel file configuration.

Settings
You can use the “Settings” action to define general properties of the time tracking dashboard
(e.g. the logo or the notification setting).

14.2 Working Time Models

The following fields are available:

Name
The name of the working time model.

Type of Working Time Model
Defines the type of working time model (e.g. flexitime).

All-In
Defines whether it is an all-in working time model (affects monthly statements).

Flexitime Period
Defines the flexitime period (month, quarter or year) for flexitime. If “Year” is selected, the start
of the flexitime period must be specified.

Warning for Time Credit From
Defines the time balance at which a warning will be issued.
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Transfer Time Balances to the Next Flexitime Period
Defines whether time balances are carried over to the next flextime period in the case of
flextime.

Maximum Transferable Negative Hours
Defines the maximum transferable minus hours to the next flexitime period.

Maximum Transferable Positive Hours
Defines the maximum transferable plus hours to the next flextime period.

Time Credit for Starting and Stopping
Defines the time credit at the start and end of time tracking.

Workday

Defines the working hours per working day. A working day can also be entered more than once,
for example, if work is done differently in even/odd weeks (can be defined via the Condition
field).

o Workday
Defines the working day (Monday to Sunday).

o Fictitious Normal Working Hours
Defines the fictitious normal working time (From, To) for flexitime.

o Normal Working Hours (in Hours)
Shows the normal working time in hours based on the fictious normal working hours.

o Core Hours
Defines the core time (From, To) for flextime.

o Mandatory Breaks
Defines break times that are mandatory (duration, time period). These are automatically
deducted if no break has been entered in the specified time period.

o Condition
Defines an app.ducx expression that can be used to determine the valid working time
definition in case of multiple entries of the same working day.

Normal Weekly Working Hours
The weekly normal working hours are used to calculate the target working hours.

Flexitime Frame
Defines the flextime frame per workday (From, To).

Overtime According to Daily Working Hours
Defines after how many daily working hours overtime is accrued.

Overtime According to Weekly Working
Defines after how many weekly working hours overtime accrues.

Maximum Daily Working Hours Without Breaks
Defines the maximum daily working time after which a break must be taken (e.g. 6 hours).

Break After Daily Maximum Working Hours
Defines the minimum required break after reaching the daily maximum working time.

Maximum Daily Working Hours (Excl. Breaks)
Defines the maximum daily working time without breaks (e.g. 11 hours).

Maximum Weekly Working Hours (Excl. Breaks)
Defines the maximum weekly working time without breaks.
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o Maximum Weekly Working Hours in Weekly Average (Excl. Breaks)

Defines the average period in weeks and the number of hours that should not be exceeded

during this period. In addition, it is possible to specify the number of hours above which a
warning is sent.

e Overtime Divider
Defines the overtime divider.

e Hour Divider
Defines the hour divider.

e Target Working Hours
The target working time is calculated individually for each employee from the overtime
payment. Defines the overtime surcharge and the cap on covered overtime per month.

e Rest Period Between Two Working Days
Defines the minimum rest break between two working days.

e Rest Period on Weekends
Defines the minimum rest break on weekends.

e Rest Period on Holidays
Defines the minimum rest break on public holidays.

e Rest Period on On-Call Service
Defines the minimum rest break for on-call service.

e Overtime Surcharges

Defines the available overtime surcharges. In the condition, an app.ducx expression can be

used to define how the surcharges are to be used in the overtime payroll.

e Overwrite Minimum Salaries According to Salary Agreement
Overwrites the minimum salaries according to the salary agreement using an app.ducx
expression.

14.3 Salary Agreement

Collective salary agreements are used to set minimum salaries for employees. These minimum

salaries are used to calculate covered overtime.
The following fields are available:

e Name
The name of the salary agreement.

e Normal Working Hours per Week (in Hours)
Defines the normal working hours per week (e.g. 38,50).

e Rankings
Defines the rankings.

e Minimum Salaries
Defines the minimum salaries per ranking with an effective date.

o Name
Defines the name of the minimum salary.

o Valid From
Defines from when the minimum salary definition is valid.

o Valid Until
Defines until when the minimum salary definition is valid.
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o Minimum Salaries per Ranking
Defines the minimum salaries per ranking,

o Overwrite Holidays of the Holiday Table
Allows to overwrite or redefine holidays of the holiday table.

14.4 Personnel File
Time recording enhances personnel files as follows.

Properties
The following time recording-specific fields can be found in the properties of personnel files:
“Salary” tab
e Current Gross Salary
Shows the current gross salary (according to the salary history).

e Salary Agreement
Shows the current salary agreement (according to the salary agreement history).

e Current Ranking
Shows the current ranking (according to the salary agreement history).

e Current Minimum Gross Salary
Shows the current minimum salary (according to the salary agreement history).

e Salary History
Defines the gross salaries in the context of a validity period.

o Salary Agreement History
Defines the salary agreements and rankings in the context of a validity period.
“Working Hours" tab
e Current Week (Actual Working Hours (Incl. Surcharges))
Shows the actual working hours incl surcharges of the current week.

e Current Month (Actual Working Hours (Incl. Surcharges))
Shows the actual working hours incl surcharges of the current month.

e Last Week

o Actual Working Hours (Incl. Surcharges)
Shows the actual working hours incl. surcharges of the last week.

o Working Hours
Shows the normal and target working hours and the actual hours covered of the last week.

e Last Month

o Actual Working Hours (Incl. Surcharges)
Shows the actual working hours incl. surcharges of the last month.

o Working Hours
Shows the normal and target working hours and the actual hours covered of the last month.

o Current Weekly Working Hours in Weekly Average
Shows the current weekly working time as a weekly average.

o Calculation Period (in Weeks)
Shows the calculation period in weeks (according to the working time model).
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o Current Weekly Working Hours in Weekly Average (Actual Hours)
Shows the actual working hours of the current weekly working time as a weekly average.

e Residual Leave (in Days)
Defines the number of residual leave days.

e Current Working Time Model
Shows the current working time model (according to the working time models field depending
on the validity date).

e Start Time Tracking From
Defines the start of time recording.

o Working Time Models
Defines the working time models in the context of a validity period.

“Working Hours Calculations” tab

o Current Flexitime Period
Shows the start and end of the current flexitime period as well as the current time credit and
the difference hours to the normal working hours.

o Last Settled Flexitime Period
Shows the data of the last settled flexitime period.

o Flexitime Periods
Shows the flexitime periods. The “Record Overtime Payment” button can be used to record the
overtime payment.

“On-Call Services” tab

e Unpaid On-Call Services
Shows the total of unpaid on-call services.

e On-Call Services
Defines the on-call services.

“Revoked Time Locks"” tab

Defines the revoked time locks during which time recording is normally not allowed.

Actions
You can perform the following actions:

e Record Working Hours Subsequently
Using the “Record Working Hours Subsequently” action, you can manually record the working
time for a working day subsequently.

e Record Absence
Using the “Record Absence” action, you can record the employee's absence.

¢ Revoke Lock Time
Using the “Revoke Lock Time"” action, you can revoke the lock time for time recording and allow
the employee to record the working time in the defined period.

14.5 Calculations

The payroll department has the following options:

Fabasoft Personnel File 51



Export absences

Absences can be exported regularly as a CSV file to a shelf. For this purpose, the appropriate
settings can be made in the personnel file configuration or personnel file shelf on the "Time
Recording” tab.

Working hours calculation
The “Execute Working Hours Calculation” context menu command is available on personnel file
shelves and individual personnel files. The working time accounting is carried out monthly.

Working hours recalculation

The “Recalculate Working Hours Calculation” context menu command is available on personnel
file shelves and individual personnel files. Thus, changes in the working time model or collective
agreement that relate to the payroll can be considered.

Export balances for accruals
The "Export Balances for Accruals” context menu command is available on personnel file
shelves and individual personnel files.

14.6 Time Tracking for Employees

As an employee, you can record your working hours in the “Personnel File Access” dashboard.
Alternatively, the corresponding actions are also available in the welcome screen.

Start Recording Working Hours

Using the “Start Recording Working Hours" action, you can start time tracking for the current
working day.

Note: If there are working days for which no working hours have been recorded, you can
record them directly. Alternatively, you can define that the information for the affected
workdays is no longer displayed.

Pause Recording Working Hours

Using the “Pause Recording Working Hours" action, you can pause time tracking for the current
workday.

Continue Recoding

Using the “Continue Recording” action, you can continue the paused time tracking for the
current working day.

Stop Recording Working Hours

Using the “Stop Recording Working Hours" action, you can stop time tracking for the current
working day.

Record Working Hours Subsequently (in the “Working Hours" area)

Using the “Record Working Hours Subsequently” action, you can manually record the working
time for a working day subsequently.

15 Workflow

Tasks to be performed can also be managed using the workflow. For general information on the
workflow, see the Fabasoft Cloud User Help (chapter “Workflow").

An ad hoc process allows you to define the process flow by yourself. Consequently, you can react
flexibly to situations for which no predefined processes are available. Recurring processes can be
efficiently represented with predefined BPMN processes.

In particular, you can use the following activities to perform the tasks in the personnel file context:
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Bulk Documents

Edit Bulk Document
Create Personnel File Documents
Print Personnel File Documents

Register Personnel File Documents

General

Close File

Close Document
Replace Document
Print Document

Register

16 Security Concept

The management of access rights is based on the defined team of the personnel file shelf.
Additionally, categories can be used to assign fine-grained access rights to personnel files,
personnel file folders and documents.

Finally, the security concept allows defining retention rules and access by employees and
supervisors.

Note: ACL is the abbreviation for “Access Control List” and defines the access rights from a
technical point of view.

16.1 Authorize Team (Personnel File Shelf)

By default only team members have access rights.

Full Control
Users with full control can change the settings of the personnel file shelf and delete personnel
files and documents permanently (if no retention rules are violated).

Change Access
Users with change access can manage personnel files and documents.

Read Access (Master Data)

In addition to the read access all master data (except sensitive master data like birthplace,
social security number, nationality, denomination, gross income, bank account and comments)
is readable.

Read Access (Restricted Master Data)

Users with read access and restricted master data access can only read a few metadata of a
personnel file. They can also navigate to personnel file folders and documents that are
specified by a category. To do so users/organizations can be defined in a category on the
“Permissions” tab in the Change Access for Objects with this Category or Read Access for Objects
with this Category field.

This way it can be realized, for example, that the IT department can save, cancel or restore
order confirmations without having access to the remaining data of the personnel file.

Skills Manager
Skills manager manage qualifications, job and role descriptions and can generate overviews of
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missing qualifications of employees.

They have access to all master data (except sensitive master data like birthplace, social security
number, nationality, denomination, gross income, bank account and comments). Skill masters
have no access to the documents of the personnel file, unless they have been authorized by a
category.

Note: Access rights can also be defined by defining access for employees and supervisors.

16.2 Category

Categories of personnel files, personnel file folders and documents can define access rights,
retention rules and automatic follow-ups.

16.2.1 Permissions

On the “Permissions"” tab following fields are provided:

o Default ACL for Objects with this Category
If an access by employees and supervisors is defined, documents can be excluded (without
access) or change rights can be granted.

e Change Access for Objects with this Category
Users who have not been defined as team members get change access on objects with this
category.

e Read Access for Objects with this Category
Users who have not been defined as team members get read access on objects with this
category.

16.2.2 Retention Worthy

Retention worthy documents cannot be deleted as long as the personnel file is “Active”. The
retention worthiness can be defined by the assigned category. To do so, in the category, on the
“Retention” tab, the Retention Worthy field must be marked.

16.2.3 Retention Periods

Retention periods prevent the deletion of personnel files or documents until the time limit expires.
Retention periods cannot be backdated.

Retention periods are, for example, used to prevent the deletion of documents for a certain period
of time after an employee leaves the company.
Categories Define the Retention Rules

In the category of personnel files or documents a retention rule is defined (example: retention
period of 30 years after an employee leaves the company).

To do so, in the category, on the “Retention” tab the Retention Worthy field must be marked. The
Retention Period and Base Date for the Beginning of the Retention Period fields the retention period
can be defined.

Apply Rules When Closing a Personnel File (Default Method)
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The background task applies the rule defined in the category at a defined point in time (example:
one day after the separation date the rule is applied).

Configure a default category for personnel files in the personnel file configuration or shelf. In the
category, specify a default background task that starts a process that contains the “Close File"
activity. For example, select “1 day” for the time interval, “After” as operator and “Separation Date
(Personnel File)” entry as base date for the time interval. This will start the close process one day
after the separation date. The retention periods are calculated and applied on closing.

Apply Rules With Background Tasks (Alternative Method)

The background task applies the rule defined in a category at a defined time (for example, the rule
is applied one day after the separation date is reached).

The background tasks can be defined either in the personnel file configuration on the “Default
Values” tab in the Default Background Tasks field or in the personnel file shelf on the “Default Values”
tab in the Additional Default Background Tasks field or in the category on the “Background Tasks” tab.

In the background task, in the Action field the Determine Retention Period Based on the Category entry
must be selected. The execution of the background task is based either on the Time Interval and the
Base Date for Time Interval or is based on a specific Date. The base date may refer either to a date
field of the document or on a date field of the assigned personnel file.

The background tasks assigned to the individual personnel files or documents can be viewed on
the “Retention” tab in the Background Tasks field (only visible if at least one background task is
available). The background tasks are taken from the personnel file shelf and from the assigned
category. If default background tasks are changed in the personnel file shelf or category, they are
not adopted automatically. An update can be performed via the context menu command “Update
Background Tasks".

16.2.4 Disposal

After the retention period documents can be deleted again. To delete documents automatically or
to start a workflow to confirm the deletion, categories and background tasks can also be used.

To do so, add in the category that defines the retention period, an additional background task. In
general, it makes sense to define the Retention Period as base date for the execution of the task. As
action, you can either select “Delete Automatically”, “Delete Automatically (Documents of Closed
Personnel Files Are Not Deleted)” or “Start Process". If you want to start a process, you must also
specify the process. In the process, a task with the activity “Retention Period Exceeded” should be
defined.

When the background task is executed, the process is started and can be processed by the defined
users in the worklist. The “Retention Period Exceeded" activity provides the steps “Delete”, “Extend
Retention Period” and “Accept”.

16.3 Personnel File Access

Accessing a personnel file by the employee himself or by supervisors can be defined on the
“Access” tab of a personnel file.

If certain documents should be inaccessible or changeable, a category can be used to define
special ACLs:

e ACL for Personnel File Documents With Change Access for Employees
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e ACL for Personnel File Documents With Change Access for Employees/Supervisors
e ACL for Personnel File Documents With Change Access for Supervisors
e ACL for Personnel File Documents Without Access for Employees

e ACL for Personnel File Documents Without Access for Employees With Change Access for
Supervisors

e ACL for Personnel File Documents Without Access for Employees/Supervisors

e ACL for Personnel File Documents Without Access for Employees/Supervisors With Change
Access for Users Participating in Workflow

e ACL for Personnel File Documents Without Access for Employees With Read Access for Users
Participating in Workflow

e ACL for Personnel File Documents Without Access for Employees With Read Access for
Supervisors/Users Participating in Workflow

e ACL for Personnel File Documents Without Access for Supervisors

17 SAP Integration

The SAP integration enables the following scenarios:

e Linking HR master data in SAP with the respective personnel files
e Storing payslips generated with SAP in the respective personnel files

¢ Export of the organizational structure from SAP and import to the Fabasoft Personnel File

17.1 Linking HR Master Data

The SAP integration allows linking HR master data in SAP with the respective personnel file. The
integration is carried out with an own information type 9600 “Fabasoft Personnel File".

Note: If new personnel files should be created via SAP, a manual assignment of personnel
numbers is required (settings of the personnel file shelf > “Numbering” tab > Generate Personnel
Number Automatically > “No").

17.1.1 Log-in via SAP

For data exchange between the Fabasoft Personnel File and SAP, you must store a password for
applications in SAP. If no or no valid password is stored, the dialog for entering the credentials is
automatically opened when you call a function that requires a connection to the Fabasoft
Personnel File.

17.1.1.1 Defining a Password for Applications in SAP

To store the credentials in SAP, perform the following steps:

1. The password dialog is opened, for example, when you execute the “Create” command on the
information type 9600 “Fabasoft Personnel File” and then click the “Personnel File” button.
Note: If the data set for the information type 9600 has already been created, execute the
“Change” command instead of “Create”.

2. Inthe Username field enter the e-mail address that you are using for logging in to the Fabasoft
Personnel File. In the Password field enter your generated password for applications. More
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3.

information about generating such a password can be found in chapter 17.1.1.2 “Generating a

[= Fabasoft Personnel Fie

Username §denver.meyer@global.com|

Pass“vard A A A A A A A A AR A A AN A A A A A A A ARARARA AR A AN

[ ]x]

Password for Applications”.
Click "OK".

The password is stored in SAP and need not be entered again as long as it is valid.

17.1.1.2 Generating a Password for Applications

To generate a password for applications, perform the following steps:

N o s~ wWwN =

Navigate in your web browser to the Fabasoft Personnel File.

Open the account menu (your user name) and click “Access for Applications".
In the Passwords for Applications field click “New".

In the Valid for field select “Fabasoft Personnel File".

Choose a validity period.

Click “Next”.

Copy the generated password in the clipboard, to be able to store it in SAP. For security
reasons, this password is displayed only once.

Click “Close”.

17.1.2 Creating a Data Set for the Information Type 9600

The link of HR master data in SAP to a personal file is carried out via the information type 9600
“Fabasoft Personnel File".

To create a data set for the information type 9600, perform the following steps:

o vk wWwN =

Switch to the SAP GUI.

Run the PA30 transaction.

Switch to the HR master data for which the data set should be created.
Select the information type 9600 “Fabasoft Personnel File”.

Execute the “Create” command, to create the data set.

The “Personnel File"” button can be used to directly create a new personnel file or to link to an
existing one. More information can be found in chapter 17.1.3 “Managing Links to Personnel
Files".

Create Fabasoft Personnel File

! M Personnel File

|JL|'|7“7||7|' @I@ Personnel No 90000003 Name Meyer Denver |

Find by EE group 1 Active Pers.area ATOL1 Personnel Area ATO1
~ 82 Person EE subgroup ZH Salaried employees
- (M) Collective search help Start 01.03.2016 To 31.12.9999

u GDI Search Term

. Gﬁ fieelseardh Fabasoft Personnel File

Personnel File Shelf

[
Click the “Save"” button to store the data set.
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Note: Delete the record for information type 9600 to remove the link to the personnel file. Deleting
the data record has no effect on the personnel file itself.

17.1.3 Managing Links to Personnel Files

The link between the HR master data in SAP and the personnel file is managed via the “Personnel
File” button of the information type 9600.

Create Fabasoft Personnel File

A | | Personnel File

The link is based on the personnel number. When creating a link to a personnel file the
corresponding personnel file shelf is automatically stored in the Personnel File Shelf field.

Depending on the use case you can carry out the following using the “Personnel File” button:

¢ If no personnel file with the personnel number exists, you can decide whether a new personnel
file should be created. If several personnel file shelves exist, you can choose in which the
personnel file should be created.
Note: Canceled personnel files are considered as existing, delete personnel files (wastebasket)

are considered as not existing.

o If a personnel file shelf is already stored in the information type 9600, the corresponding
personnel file with the associated personnel number is opened.

¢ If only one personnel file with the associated personnel number exists within all personnel file
shelves, the link will be automatically created. If the personnel number exists in several
personnel file shelves, you can choose one personnel file shelf.

e If the HR master data in SAP differs from the personnel file you can decide whether the data of
the personnel file is replaced by the HR master data in SAP (see also next chapter).

[ Fabasoft Personnel File

The master data in SAP and the Fabasoft

Personnel File are different.

9 Do you want to update the master data in the

Fabasoft Personnel File now?

EQ? Yes 1|X No ‘

¢ In all use cases the linked personnel file is opened in the web browser, if you allow the access
in the displayed dialog.

¢ If the personnel file shelf has changed you have to save the data set of the information type
9600 again. In this case open the data set with the “Change” command instead of “Display”.

17.1.4 Synchronizing HR Master Data

When opening a personnel file via SAP the following HR master data is matched and, if desired,
overwritten in the personnel file:

“Master Data"” tab

e Surname
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e First Name

o Tittle

e PostTitle

¢ All Previous Names

¢ Date of Birth

e Social Security Number
e Entry Date

e Separation Date

“Contact Data” tab

1

e Bank Account

e Address

e Telephone Numbers
e E-Mail Addresses

¢ Language for Communication

7.2 Storing Payslips

SAP-generated payslips can be automatically stored in the respective personnel file.

Transfer Payslips to the Fabasoft Personnel File

% o = [E Bl © orgStructure ¢ Search Help

Payrol Period

Period Current Payroll Period -
Payroll Area -
Period a

Selection Criteria

Personnel Number

o

Payroll area

Selaction options
Form FABA PFRYSLIF_AT

Country Grouping 03

Define Login Data

Define Login Data

Options for File Names
Pattern for File Names PAYSLIP_&1-82.pdf
Placeholders for File Mames YYYY;MM

To store the payslips in the respective personnel files, perform the following steps:

1.
2.

Switch to the SAP GUI.

Run the SE38 or SA38 transaction and execute the report /FABASOFT/VDN2RECM.

Note: Alternatively, the transaction /FABASOFT/VDN2RECM i also available.

(prefilled), your Fabasoft Personnel File user name (e-mail address) and the password for

Fabasoft Personnel File

Click “Define Login Data". If you want to run the report interactively, enter your SAP user name
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applications (see chapter 17.1.1.2 “Generating a Password for Applications”). Click “OK".
Note: If another SAP user is intended to generate the report (for example, for background
processing), perform this step again to store additional log-in information.

4. Select the required payroll period and selection conditions.

5. Inthe Selection Options, select the HR form for the payslip (must correspond to the HR form
specified in the configuration) and specify the Country Grouping of the HR form (according to
the HR form definition in HRFORMS).

6. Inthe Options for File Names, specify a pattern for file names (e.g. payslip s1-&2.pdf). For the
placeholders s1, «2, etc. used in the pattern, you must define a corresponding number of
placeholder values separated by semicolons in the Placeholders for File Names field. The
following placeholder values are available: yyvyy (year of the period, four digits), vy (year of the
period, two digits), M1 (month of the period) and pERNR (personnel number).

7. Click the “Execute” button.

17.3 Export and Import of the Organizational Structure

A CSV file describing the organizational structure can be generated from the organizational chart
and employee master data available in SAP. The organizational structure can be transferred using
the import mechanism of the Fabasoft Personnel File.

Export from SAP
To export the organizational plan, proceed as follows:

1. Switch to the SAP GUI.
Call transaction SE38 or SA38 and execute program ZHR_EXPORT_ORG.
Specify the following data:

o Key Date
The organizational structure is generated for the specified key date. If you want to save a
variant that uses the current date, save the field without a value.

o Plan Version
Plan version 01 (current plan version) is used by default.
o Source Object
Defines the organizational unit that serves as root of the exported organizational structure.
o Directory
The CSV file is stored in the specified directory on the SAP application server.
Note: For further use, for example, an automatic copy task can be set up at operating
system level which copies the stored files to a Teamroom connected via WebDAV as a
network drive.
o File Name
Specifies the file name of the CSV file. <DaTE> can be used as placeholder for the key date.
o Overwrite
Specifies whether an existing file with the same name should be overwritten.

o With Header
Determines whether column headers are generated in the CSV file.

o Level with “OUTLevel" Prefix
Determines whether the prefix “OUTLevel" is added to the level of the organizational unit.
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4. Click the "Execute” button.

Note: To keep the organizational structure up to date, you can create a variant with the required
data and execute it in the background.

Import into the Fabasoft Personnel File

To import or update the organizational structure, perform the following steps:

Switch to the Fabasoft Web Client.

In the organization's dashboard, click Members to open the member management.
In the member management click Organizational Structure.

Click the “Import Organizational Structure” action.

Select the CSV file exported from SAP.

Click “Start Import”.

own s~ N =

18 Administration Tasks

In the following chapters you find administration tasks for the personnel file.

18.1 Prerequisites

To be able to use the personnel file, it is necessary that the “Personnel File” service package is
activated. In addition, the service packages “Personnel File (Access)’ and “Skills Management” are
available as optional extensions. This can be checked in the properties of the organization (Service
Packages > Editions and Apps).

After purchasing the service package the organization owner, organization administrators and
payment user get a notification in the welcome screen that a personnel file configuration must be
created.

You can forward the notification to a responsible person or create a configuration immediately.
After creating a configuration, the corresponding personnel file dashboard is put on “Home" of the
specified personnel file administrators and the notification will be removed from all receivers.

Note: If a personnel file administrator is removed from the configuration, the personnel file
dashboard is removed from “Home” of the corresponding user.

18.2 Personnel File Configuration

In the personnel file configuration common settings, the structure of personnel files and the
personnel file users are defined. The defined personnel file administrators can edit the
corresponding personnel file configurations.

18.2.1 Dashboard

In the dashboard of the personnel file configuration you can define following settings. If a field is
hidden, you can display it using the “View” menu.

e Personnel File Shelves
The personnel file shelf is used to manage the personnel files and to specify the access rights.
More information can be found in chapter 18.3 “Personnel File Shelf”.
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Applicant File Shelves
shows the applicant file shelves that are used to manage the applicant files.

Business Case Shelves
Shows the business case shelves that are used to manage the business cases.

Folder Structure for New Personnel Files
The defined folder structure is assigned to each newly created personnel file.

o You can define a personnel file folder hierarchy. To do so, navigate in the tree view to a
superordinate personnel file folder, open the context menu in the tree view and click the
“Create Personnel File Folder” command.

o Inthe personnel file folders, you can store standard documents. When creating new
personnel files the personnel file folders and documents are duplicated. The document's
category will be retained.

o The predefined personnel file folders cannot be removed from a personnel file. If you need
several folders only in special personnel files, define the folders manually in the
corresponding personnel files.

o A modified folder structure only applies to newly created personnel files. But you can update
the folder structure of existing personnel files (see chapter 18.7 “Update Settings").

o Inthe Default Category field a category can be defined that is assigned to the corresponding
personnel file folder in the personnel file. Only categories are selectable that are defined in
the Categories field (personnel file configuration).

Note: The category is also propagated to documents in the personnel file folder. If the
categories are restricted in the Available Categories field, the category is only propagated if it
listed as available category.

Categories are used to define access rights, retention rules and follow-ups.

o With the Available Categories field the categories that can be assigned to documents in a
personnel file folder can be restricted. Only categories can be selected that are allowed in
the superordinate hierarchy.

Working Time Models
Shows the defined working time models (if time tracking is enabled).

Salary Agreements
Shows the defined salary agreements (if time tracking is enabled).

Forms and Categories

The here defined categories can be assigned to personnel file folders and documents.
Personnel file folders can restrict the defined categories.

Forms can be used to allow employees to create objects based on the forms using the
personnel file access dashboard. For example, employees can create leave requests.

Processes
Shows the available user-defined processes.

Templates
In the create dialog (e.g. “New” context menu command in a Teamroom) the templates are
displayed according to the grouping by the template categories.

Text Modules
The defined text modules can be inserted into Word documents.

Thesauri
Shows the thesauri in which terms for tagging of documents can be managed. At least one
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thesaurus has to be created so that the tagging can be used. The default thesaurus for new
terms is defined in the settings of the personnel file configuration. Thus, new terms can be
created directly in the tagging process. If no standard thesaurus is specified, only the
predefined terms in the thesauri can be used.

Note: Thesauri can also be defined for personnel file shelves.

e Presettings
Shows the defined display settings, search forms, and time intervals.

e Companies
If a corporation consists of several companies, the defined companies can be assigned in
positions.

e locations
The defined locations can be assigned in positions.

e Report Templates
Defines which report templates are available for generating reports. Predefined templates can
be found here;
Fabasoft Personalakte - Berichtsvorlagen (Deutsch)
Fabasoft Personnel File - Report Templates (English)
The report templates may be modified with the third-party product Eclipse BIRT
(http://download.eclipse.org/birt/downloads/).

o Failed Background Tasks
Shows failed background tasks (only visible, if at least one failed background task is available).
You can perform following manual actions: “Define Next Execution”, “Send Link” and “Delete”.

You can define more settings with the “Settings” action (see chapter 18.2.8 “Settings").

18.2.2 Create Personnel File Shelf

With the “Create Personnel File Shelf” action you can create a personnel file shelf. More information
can be found in chapter 18.3 “Personnel File Shelf".

18.2.3 Create Applicant File Shelf

With the “Create Applicant File Shelf” action you can create an applicant file shelf.

18.2.4 Create Business Case Shelf

With the “Create Business Case Shelf” action you can create a business case shelf.

18.2.5 Import Predefined Values

Predefined values for drop-down fields (like employment type) can be imported and updated using
a CSVile..

To import predefined values, perform the following steps:

1. Click the “Import Predefined Values” action.

2. Optionally, click the “Download CSV Template” to retrieve a template that describes the
necessary data structure.

3. Enter the path to the CSV file in the Content field.
4. Click "Start Import".
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5. After the import has finished click “Next".

The CSV columns are in general free-text fields of type string, number or date. Following CSV

columns are available:

CSV Column Field Possible Value

1d Import ID String

Class Reference Reference of an object class
(EmployeeCompany,
EmployeeLocation)

Name Name String

Description (currently not used)

Street Address (Street) String

zipCode Address (Zip Code) Number

City Address (City) String

State Address (State) String

Country Address (Country) String

Emaill E-Mail Address (Topic: E-Mail 1) String

Email2 E-Mail Address (Topic: E-Mail 2) String

Email3 E-Mail Address (Topic: E-Mail 3) String

Phone Telephone Numbers (Topic: String

Business)
Fax Telephone Numbers (Topic: Fax) String
CommLanguage Language for Communication Reference of a system language

(e.g. LANG_GERMAN, LANG_ENGLISH)

18.2.6 Import Categories

Categories can be imported and updated using a CSV file..

To import categories, perform the following steps:

1.
2.

Click the “Import Categories” action.

In the personnel file configuration navigate in the “Categories” area.

Optionally, click the “Download CSV Template” to retrieve a template that describes the
necessary data structure.

Enter the path to the CSV file in the Content field.
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5. Click “Start Import”.

6. After the import has finished click “Next".

The CSV columns are in general free-text fields of type string. Following CSV columns are available:

CSV Column Field Possible Value
Id Import ID String
Name Name String
PersonnelFileShelf | Fahasoft Cloud ID or Import ID String (category is stored in the
1d .

(Personnel File Shelf) personnel file shelf)
RetentionWorthy Retention Worthy Boolean value (true or false)
RetentionPeriod

Retention Period

Reference of a time interval (e.g.
FSCSCHEDULE@1.1001:TimeInterva

130Y00MOOWOODOOHOOMOOS)

RetentionBaseDate

Base Date for the Beginning of the
Retention Period

Reference of a property (e.g.
FSCSCHEDULE@1.1001:CreatedAtDa

teTimeDef)

UsableFor Applicable for Reference of an object class (e.g.
FSCPERSONNELFILE@1.1001:Person
nelFileDocument)

Caliegeu el Default ACL for Objects With This Reference of an ACL (e.g.

Category FSCPERSONNELFILEQ@1.1001:RoomPe
rsonnelFileEmployeeACL)
CatSecChange Change Access for Objects With This | E-Mail address of a user
Category

CatSecRead Read Access for Objects With This | E-Mail address of a user
Category

OverrideKeys - CSV columns of properties to be

overwritten separated by commas
(otherwise empty values are ignored
and values are added in list
properties)

18.2.7 Import Folder Structure

Personnel file folder templates can be imported and updated using a CSV file..

To import personnel file folders, perform the following steps:

1. Inthe personnel file configuration navigate in the “Folder Structure for Personnel Files” area.

2. Click the “Import Personnel File Folders” action.
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3. Optionally, click the “Download CSV Template” to retrieve a template that describes the
necessary data structure.

4. Enter the path to the CSV file in the Content field.

5. Click “Start Import".

6. After the import has finished click “Next".

The CSV columns are in general free-text fields of type string. Following CSV columns are available:

CSV Column Field Possible Value
- Import ID String
WErme Name String
EzrsonnelFileShelf Fabasoft Cloud ID or Import ID String (personnel file folder is stored
(Personnel File Shelf) in the personnel file shelf)
p
Parentld Import ID (superordinate personnel |String
file folder)
DefaultCategory Default Category Import ID of a category
Categories Available Categories Import ID of a category
OverrideKeys - CSV columns of properties to be
overwritten separated by commas
(otherwise empty values are ignored
and values are added in list
properties)

18.2.8 Settings

Beside the settings in the dashboard the “Settings” action provides following possibilities:

“General Settings” tab

e Name

The name of the configuration.

o Subject

Defines an additional description of the configuration.

e Mindbreeze InSpire Service
If Mindbreeze InSpire services for the classification of documents are available in your
organization, here you can select a service, which is used when storing documents in a
personal file. If you do not select one, no classification is performed.

Note: The service only applies when documents are directly placed in a personal file. For

example, if you register a document that is assigned to a Teamroom using the context menu
command, the service defined in the Teamroom or the default service (when not defined) is
used.
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Holiday Table
Defines the holiday table to be used in the configuration context (otherwise the default holiday
table is used).

Restrict Shortcuts Within Teamroom
Defines which type of shortcuts may be stored in the configuration.

Restrict the Downloading or Opening of Content on the Device
Allows to restrict team members who can open or download content on the device.

Restrict Team Members
Defines the organizations, organizational units, teams and external organizations whose
members may be added to the configuration.

Main Administrator

Defines the user who will receive the automatically generated e-mail messages concerning the
configuration. Otherwise, all app administrators receive the e-mail messages. The user is also
listed as contact in case of missing permissions.

Support Team
The support team handles the organization-internal management of support requests in the
respective context.

Enable Advanced Mode
Advanced mode includes, for example, working with multiple shelves, as well as managing
templates and presettings.

Activate Trace Output

For example, as a form designer, when you use expressions for calculation or validation, it can
sometimes be difficult to identify errors in the expressions. To simplify analysis, you can write
trace output to the web browser console (cooobj . Trace ("string") ; or

cooobij.Trace ("string", value);).

“Personnel File Configuration” tab

Show “Pre-Capture” Action
Defines whether the barcode scan functionality is available.

Scan Documents as
Defines the document type (PDF or TIFF) of the pre-captured document.

Root Structure is Extensible
Defines whether personnel file folders can be manually added to personnel files at top level
(additionally to the predefined structure).

Keep a Copy of the Personnel File When Changing the Assignment
Defines whether a copy of a personnel file is kept in the current personnel file shelf when the
assignment is changed.

Externally Managed Master File Data

To prevent that fields (that should be updated by an import or via the SAP integration) are
changed directly in the personnel file using the web environment, it is possible to set the
corresponding fields read-only. This applies only to personnel files for which the “Managed
Externally” option is enabled.

Transfer Changes in the Master Data to Other Personnel Files of the Same Person
Defines whether master data in personnel files that affect the same person should be
transferred when changes are made.
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You can define a key for identifying the personnel files and the master data to be transferred.
The selected master data is only synchronized for active personnel files.

¢ Enable E-Mail Notification for Birthdays
Defines whether e-mail notifications for birthdays are sent to the defined supervisors and
additionally defined e-mail addresses.

¢ Send E-Mail Notification to Supervisors (Birthdays)
Defines whether e-mail notifications are sent to none, direct or all supervisors.

o Further E-Mail Recipients (Birthdays)
Defines the e-mail addresses (one per line) to which the notifications should be sent.

e Enable E-Mail Notification for Anniversaries
Defines whether e-mail notifications for anniversaries are sent to the defined supervisors and
additionally defined e-mail addresses.

e Send E-Mail Notification to Supervisors (Anniversaries)
Defines whether e-mail notifications are sent to none, direct or all supervisors.

o Further E-Mail Recipients (Anniversaries)
Defines the e-mail addresses (one per line) to which the notifications should be sent.

o Language for E-Mail Notifications (Birthdays and Anniversaries)
Defines the language in which the notifications are sent.

o Locale for E-Mail Notifications (Birthdays and Anniversaries)
Defines the locale in which the notifications are sent.

“Personnel File Access"” tab

e Permanent Access for Employees
Defines whether the user for employee access is taken from the organizational structure.

e Permanent Access for Supervisors
Defines whether the users for supervisor access are taken from the organizational structure.

e Changes in the Organizational Structure Regarding the Personnel File Access Are Confirmed by
The specified user can confirm changes in the organizational structure regarding the personnel
file access via the workflow.

e Self-Managed Master Data
The selected master data can be edited by the user who is assigned to the personnel file.

o Members/Employees Can Upload Documents
Defines whether employees are allowed to upload documents in their own list, which can
subsequently be registered by a personnel file user.

e Default Process for Uploaded Documents
The defined process is automatically started on documents uploaded by employees.

e Actions in Dashboard
Defines actions to create form objects which are displayed in the personnel file access
dashboard.
Procedure: To do this, define the required form in the Forms and Categories area of the
configuration and release it for use. The form can be used in the Actions in Dashboard field. In
addition, define a title and a symbol for the action. Select a personnel file folder in which the
created objects are to be stored. The personnel file folder must have a default category that
allows users with access to store objects (Change Access for Objects with this Category). The
Expression for Determining the Visibility field can be used to define for whom the action is
displayed.
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Permissions for Temporary Access
The defined permissions are offered for selection when granting temporary access. The access
right (“No Access”, “Read Access” and “Change Access”) can be defined per category.

“Numbering” tab

Check Uniqueness of Personnel Numbers Across All Personnel File Shelves
Defines whether the uniqueness of personnel numbers is checked across all personnel file
shelves or only within one personnel file shelf.

Generate Personnel Number Automatically

Determines whether the personnel number is automatically generated. If not, the personnel
number must be entered manually when creating a personnel file.

Note: If personnel numbers are automatically generated, no new personnel files can be
created by the import mechanism.

Last Used Number
The defined number plus one is assigned to the next created personnel file.

Format String
The number of zeros entered specifies the number of digits in the personnel number.

Format Prefix
A string that precedes the personnel number.

Used Format Prefixes
Shows an overview of format prefixes the have been used by now.

“Consistency Check” tab

Enable Consistency Check

Defines whether a consistency check is performed regularly in the background for all personnel
files. The check is also performed when a document is added to or removed from a personnel
file.

Rules for the Consistency Check

Defines the rules for the consistency check. You can use a rule to check whether a document
with the defined category exists in every personnel file. In addition to the category, other
conditions can also be defined for the document.

o Category of the document
Defines that a document with this category must exist.

o Restrict Scope
Only personnel files assigned to a position that has one of the defined companies and one
of the defined locations are taken into account for the consistency check.

o Check Personnel File Folder of the Document
Defines that the document must be in one of the defined personnel file folders.

o Check Validity of the Document
Defines that the document must be valid (Valid From and Valid to).

o Check Age of the Document (Created on/at)
Defines that the creation date of the document must not be older than the defined time
span.

o Rule May Be Ignored for Certain Personnel Files
Defines whether the rule can be disabled for individual personnel files.
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o Name
The name of the rule.

“SAP Settings” tab

The HR master data of the current employee can be displayed via the PA30 transaction in SAP. On
this tab you can define the necessary connection parameters. Consult your SAP administrator to
inquire the settings.

Note: These settings allow opening the HR master data in SAP starting from the Fabasoft
Personnel File ("Open SAP HR Master Data” context menu command). The SAP integration however
allows opening the personnel file starting from SAP (see chapter 18.10 “SAP Integration”).

“Time Recording” tab

The regular export of absences can be defined on this tab. The corresponding CSV file will be
stored in the specified shelf.

“Skills Management” tab

On this tab, you can define a user who confirms further trainings. You can also manage the rating
scales for qualifications.

Note: Only visible if skills management is used.
“Applicant Management"” tab

On this tab, you can define the default category for applicant files in the talent pool. In addition, you
can define application sources as terms. The Enable Website Integration option enables the
automatic creation of applications via an HTML form. This gives the user for website integration
access to the personnel file configuration and the applicant file shelves.

“Logos” tab

The defined logos and the background image are used for the personnel file configuration and for
all personal dashboards.

“Default Values” tab

o Default Thesaurus for New Terms
If a default thesaurus is specified, new terms can be created directly during tagging.

o Default Categories
When an object is created, the specified category is assigned according to the defined object
class. In the Apply to field, you can specify whether the setting applies to instances, templates,
or both.

o Default Processes
When an object is created, the specified process is assigned according to the defined object
class or category. In the Apply to field, you can specify whether the setting applies to instances,
templates, or both.

o Default Background Tasks
When an object is created, the specified background tasks are assigned.

e Release Process for Templates and Presettings
In order to use templates, text modules, forms and categories, processes and presettings, they
must be released. If a process is to be used for the release, a BPMN process diagram can be
defined here. Release processes must contain the "Release for Usage" activity.

“Content Settings” tab
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On this tab you can define whether a generated cover sheet should be added to PDF overviews of
documents.

In addition you can define watermark settings. With the Watermark for All Users option you can test
the settings by yourself, The settings also apply to the assigned personnel file shelves, if they do not
define their own settings.

If you use watermarks, the PDF overview of a personnel file will be watermarked. In addition users
with read access do not see the original documents of a personnel file but the corresponding
converted and watermarked PDF documents.

18.2.9 Authorize Team

To enable users to use the personnel file, they must be authorized in the personnel file
configuration. On the basis of the specified users the consumed licenses of the respective service
packages are calculated.

¢ Full Control (read-only)
The owner and co-owners of the organization have full access.

e Personnel File Administrator
Personnel file administrators can edit the personnel file configuration. Users get the service
package “Fabasoft Personnel File”.

e Personnel File User
Personnel file users are entitled to use the Fabasoft Personnel File. The respective rights are
defined in the personnel file shelves. Users get the service package “Fabasoft Personnel File”.

e Personnel File Access
The access right allows read access to personnel files. Users get the service package “Fabasoft
Personnel File (Access)".

¢ Skills Management
The skills management allows managing qualifications, job and role descriptions and the
generation of overviews of missing qualifications of employees. Users get the service package
“Skills Management”.

e Applicant Management
The applicant management allows managing applicant files, job advertisements and job
applications.

18.3 Personnel File Shelf

The personnel file shelf is based on a personnel file configuration, but the defined settings can be
overwritten or extended. The personnel file shelf is used to manage the personnel files and to
specify the access rights.

Settings made in the personnel file shelf override settings of the personnel file configuration
(exception: “Extensions” tab).

“General Settings” tab

e Name
Defines the name of the personnel file shelf.

e Subject
Defines a further description.
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App Configuration
The personnel file shelf inherits the settings of the assigned app configuration.

Mindbreeze InSpire Service

If Mindbreeze InSpire services for the classification of documents are available in your
organization, here you can select a service, which is used when storing documents in a
personal file. If you do not select one, either the service defined in the personnel file
configuration is used (if defined) or no classification is performed.

Note: The service only applies when documents are directly placed in a personal file. For
example, if you register a document that is assigned to a Teamroom using the context menu
command, the service defined in the Teamroom or the default service (when not defined) is
used.

Holiday Table
Defines the holiday table to be used in the shelf context.

Restrict Shortcuts Within Teamroom

Defines which shortcuts can be stored in the personnel file shelf. Allows, for example, storing
categories of user-defined forms.

Note: If you want to allow categories of user-defined forms, select “Default: Allow shortcuts to
all objects” because these categories are not assigned to any organization.

Roles That Are Allowed to Open or Download Content on the Device
Defines which permissions a team member must have in order to open or download content at
the device.

Restrict Team Members
Defines the organizations the team members have to belong to.

Main Administrator

Defines the user who will receive the automatically generated e-mail messages concerning the
shelf. Otherwise, all shelf administrators receive the e-mail messages. The user is also listed as
contact in case of missing permissions.

Support Team
The support team handles the organization-internal management of support requests in the
respective context.

Activate Trace Output

For example, as a form designer, when you use expressions for calculation or validation, it can
sometimes be difficult to identify errors in the expressions. To simplify analysis, you can write
trace output to the web browser console (cooobj . Trace ("string") ; or

cooobij.Trace ("string", value);).

“Personnel File Shelf” tab

Calculate Statistics
Defines whether graphically processed statistics for the personnel files are shown in the
dashboard.

Show “Pre-Capture” Action
Defines whether the barcode scan functionality is available.

Scan Documents as
Defines the document type (PDF or TIFF) of the pre-captured document.

Root Structure is Extensible
Defines whether personnel file folders can be manually added to personnel files at top level
(additionally to the predefined structure).
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Keep a Copy of the Personnel File When Changing the Assignment
Defines whether a copy of a personnel file is kept in the current personnel file shelf when the
assignment is changed.

Externally Managed Master File Data

To prevent that fields (that should be updated by an import or via the SAP integration) are
changed directly in the personnel file using the web environment, it is possible to set the
corresponding fields read-only. This applies only to personnel files for which the “Managed
Externally” option is enabled.

Enable E-Mail Notification for Birthdays

Defines whether e-mail notifications for birthdays are sent to the defined supervisors and
additionally defined e-mail addresses.

Send E-Mail Notification to Supervisors (Birthdays)

Defines whether e-mail notifications are sent to none, direct or all supervisors.

Further E-Mail Recipients (Birthdays)

Defines the e-mail addresses (one per line) to which the notifications should be sent.
Enable E-Mail Notification for Anniversaries

Defines whether e-mail notifications for anniversaries are sent to the defined supervisors and
additionally defined e-mail addresses.

Send E-Mail Notification to Supervisors (Anniversaries)

Defines whether e-mail notifications are sent to none, direct or all supervisors.

Further E-Mail Recipients (Anniversaries)
Defines the e-mail addresses (one per line) to which the notifications should be sent.

Language for E-Mail Notifications (Birthdays and Anniversaries)
Defines the language in which the notifications are sent.

Locale for E-Mail Notifications (Birthdays and Anniversaries)
Defines the locale in which the notifications are sent.

“Personnel File Access” tab

Permanent Access for Employees
Defines whether the user for employee access is taken from the organizational structure.

Permanent Access for Supervisors
Defines whether the user for supervisor access is taken from the organizational structure.

Changes in the Organizational Structure Regarding the Personnel File Access Are Confirmed by
The specified users can confirm changes in the organizational structure regarding the
personnel file access via the workflow.

Self-Managed Master Data
The selected master data can be edited by the user who is assigned to the personnel file.

Members/Employees Can Upload Documents
Defines whether employees are allowed to upload documents in their own list, which can
subsequently be registered by a personnel file user.

Default Process for Uploaded Documents
The defined process is automatically started on documents uploaded by employees.

“Numbering” tab
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o Generate Personnel Number Automatically
Determines whether the personnel number is automatically generated. If not, the personnel
number must be entered manually when creating a personnel file.

o Last Used Number
The defined number plus one is assigned to the next created personnel file.
e format String
The number of zeros entered specifies the number of digits in the personnel number.

e Format Prefix
A string that precedes the personnel number.

Note: If it is defined in the personnel file configuration that unique personnel numbers should be
used across all personnel file shelves, no specific settings can be made for the personnel file
shelves.

“SAP Settings” tab

The master data of the current employee can be displayed via the PA30 transaction in SAP. On this
tab you can define the connection parameters. Consult your SAP administrator to inquire the
necessary settings.

“Time Recording” tab

The regular export of absences can be defined on this tab. The corresponding CSV file will be
stored in the specified shelf.

“Extensions” tab

e Additional Personnel File Folders
Defines personnel file folders in addition to the personnel file folders defined in the personnel
file configuration.

o Additional Rules for the Consistency Check
Defines rules for the consistency check in addition to the rules defined in the personnel file
configuration.

o Additional Report Templates
Defines report templates in addition to the report templates defined in the personnel file
configuration.

“Logos” tab
The defined logos are used for the personnel file shelf.
“Default Values” tab

o Default Thesaurus for New Terms
If a default thesaurus is specified, new terms can be created directly during tagging.

o Default Categories
When an object is created, the specified category is assigned according to the defined object
class.

e Additional Categories
Defines categories in addition to the categories defined in the configuration.

e Default Processes
When an object is created, the specified process is assigned according to the defined object
class.
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o Additional Default Background Tasks
When an object is created, the specified background tasks are assigned.

“Content Settings” tab

o Allow Comments
Defines whether PDF comments can be applied to documents.

o Allowed Types for Comments
Defines the allowed types of comments (public or private).

e Preferred Type for Comments
Defines the type of comment initially selected when commenting (overrides the setting in the
configuration or user's basic settings).

o Users With Read Access Are Allowed to Comment Publicly
Defines whether users with read access are allowed to add public comments (overrides the
setting in the configuration).

o Allow Public Links
Defines whether public links may be published.

o Generate Cover Sheet for PDF Overviews of Documents
Defines whether a cover sheet is generated for PDF overviews of documents.

o Use Watermarks
If you use watermarks, the PDF overview of a personnel file will be watermarked. In addition,
users with read access do not see the original documents of a personnel file but the
corresponding converted and watermarked PDF documents.

18.4 Providing the Scan Functionality (Pre-Capture)

To provide the scan functionality, the scanner software must upload the document via a web
service to the Fabasoft Personnel Flle (see chapter 8.6 “Pre-Capturing a Document for a Scan”).

Use Case:

The user defines a document that should be scanned (identified by a barcode). The scanner
software reads the barcode on the paper document and sends the scanned file including the
barcode via a web service to the Fabasoft Personnel File. The document that has been defined by
the user gets populated with the scanned content.

18.5 Creating Personalized Word Templates

To create personalized Word templates, metadata (e.g. salutation or address) of personnel files can
be inserted as updateable DocProperties or fields in Word documents. The “Insert DocProperties”
and “Insert Field” buttons are available in Microsoft Word on the “Fabasoft Cloud” tab (the Fabasoft
Folio COM Add-in has to be enabled).

18.6 Inbox

In an inbox, rules for the processing of incoming objects can be defined. A rule consists of
conditions and actions.

You can create the inbox directly on “Home" (background context menu > “New” > “Inbox"). As for
Teamrooms, you can also set a team for inboxes to define the access rights.

For example, the documents can be stored in the inbox via WebDAV.

Fabasoft Personnel File 75



Assigning
Documents can be automatically replaced by incoming documents.

Create an inbox and define a rule. In the rule, define two actions. The first action “Assign Category”
is used to assign a category to incoming documents that has set the value "Personnel File
Document Incoming Category" as Incoming Category for Registration. The second action “Assign
(Asynchronous)” is used to replace the documents. The replacement can be based on QR codes
(bulk documents) or PDF keywords. The Fabasoft Cloud ID (e.g. COO. 1.506.4.4063) of the document
whose content is to be replaced by the incoming document must be stored in the QR code or PDF
keywords. For non-assignable documents, a further inbox can be defined as target. In this inbox, a
rule for starting a process for the manual assignment can be defined (“Register” activity).

Classifying and Assigning Personal File Document

Incoming documents can be classified with Mindbreeze InSpire and then registered to a personnel
file based on the extracted metadata.

Create an inbox and define a rule. In the rule, define two actions. The first action “Classify With
Mindbreeze InSpire” is used to perform the classification with the specified Mindbreeze InSpire
service. The second action “Assign Personnel File Document (Asynchronous)’ is used to register the
document to a personnel file. For non-assignable documents, a further inbox can be defined as
target. In this inbox, a rule for starting a process for the manual assignment can be defined
("Register” activity).

For more information on defining the Mindbreeze InSpire Service, see chapter 18.9 “Classifying
With Mindbreeze InSpire”.

Import Data
The content of incoming CSV files can be imported automatically.

You can download templates for the CSV files via the respective manual actions (e.g. “import
Categories” action of a personnel file configuration).

Create an inbox and define a rule. In the rule, define an “Import Data” action. Define the target for
the import and the type of import (e.g. import personnel files).

18.7 Update Settings

Changes to the predefined folder structure and categories are not automatically applied to existing
personnel files and documents. The “Update Settings” context menu command of a personnel file
shelf or a personnel file can be used to apply the changes.

e Background Tasks
Changes to the Default Background Tasks of the personnel file configuration, personnel file shelf
and categories are applied.

e Follow-Ups
Changes to the Default Follow-Ups of the categories are applied.

e ACL Object (Access Rights)
The Default ACL for Objects with this Category of the category is applied, if an ACL is defined.

e Folder Structure
Changes in the predefined folder structure are applied. This includes adding, removing and
modifying folders.
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Removed predefined folders will be deleted, if they are empty. If not, the folder is marked as
not predefined and can therefore be handled manually (this behavior can be changed by the
next option such that contents are moved to the parent folder if possible).

When changing predefined folders the name, the subject, the default category and the
available categories are taken into account.

e Move Documents From Deleted Folders to the Superordinate Folder
If predefined folders were removed, the corresponding folders will be deleted and the content
is moved to the superordinate folder. If the removed predefined folder is a top-level folder, the
folder will remain (if there is a content) and will be marked as not predefined.

Note: The “Update Settings” context menu command is also provided for applicant file shelves and
applicant files. It can be used to update background tasks, follow-ups and ACL objects.

18.8 Perform a Consistency Check

If rules for the consistency check have been defined in the personnel file configuration or in the
personnel file shelf, a consistency check is performed regularly in the background for all personnel
files. The check is also performed when a document is added to or removed from a personnel file.

The consistency check can also be performed manually on a personnel file shelf or personnel file
using the “Perform Consistency Check” context menu command. Inconsistencies are visualized in
the affected personnel files or documents with a corresponding status symbol. A list of all
inconsistent personnel files can be found in the “Inconsistent Personnel Files” widget.

If you have defined that a rule may be ignored for individual personnel files, you can disable the
rule in the properties of the affected personnel file on the “Consistency Check” tab using the
“Ignore Rule for This File” context menu command. To enable the rule again, you can use the
“Check Rule for This File” context menu command.

18.9 Classifying With Mindbreeze InSpire

To enable automatic classification with Mindbreeze InSpire, a Mindbreeze InSpire service must be
configured. Mindbreeze InSpire services can be created in the organization (“Advanced Settings")
and can be selected in the personal file configuration or personal file shelf. Contact Mindbreeze
InSpire Support to determine the specific settings for the service.

The following steps explain the basic operation:

1. In alearning phase, Mindbreeze InSpire is trained to classify the documents. For the extraction
of the metadata from documents, regular expressions can be defined.

2. Inthe productive mode, when executing the “Classify and Register” context menu command or
when directly storing documents in a personal file, the classification and the metadata are
requested from the Mindbreeze Inspire service.

3. For the classification value, a category with a corresponding import ID is searched and assigned
to the document.

4. Classify and register using the context menu
If a category is found that is defined in a personnel file configuration, registration is started as a
personnel file document.
Classify and register by direct storage
Regardless of the category found, registration is started as a personnel file document.
Classify with an inbox
Classifying can also be carried out automatically via an inbox.
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5. If metadata can be obtained from the document, it will be prefilled. The reference of the
respective property is used as key.
Note: If the Mindbreeze InSpire keys do not correspond to the personnel file keys, a
corresponding mapping must be defined in the Mindbreeze InSpire service.

The Fabasoft Personnel File provides the following keys for the automatic identification of a
personnel file:

Personnel File Key Description

personnel file shelf (Fabasoft Cloud ID or
import ID; optional)

FSCPERSONNELFILE 1 1001 pfpersnum personnelnurnber

FSCPERSONNELFILE 1 1001 pfsocialsecid socblsecurtynurnber

COOSYSTEM 1 1 userfirstname first name

COOSYSTEM 1 1 usersurname surname

fullname first name and surname

FSCFOLIO 1 1001 persbirthday birth date

COOMAPI 1 1 emailaddress e-mail address

The evaluation is carried out in following order (if a match is made the remaining steps are not
executed):

1. FSCPERSONNELFILE 1 1001 pfpersnum
FSCPERSONNELFILE 1 1001 pfsocialsecid

COOSYSTEM 1 1 userfirstname,COOSYSTEM_l_l_usersurnameand

FSCFOLIO 1 1001 persbirthday
4, fullname and FSCFOLIO 1 1001 persbirthday

5. COOMAPI 1 1 emailaddress

The Fabasoft Personnel File provides following key for classification:

Personnel File Key Description

COOTC_ 1 1001 objcategory category

The personnel file folder is determined via the category, but can also be defined via the
FSCPERSONNELFILE 1 1001 persfilefolderid key (Fabasoft Cloud ID or import ID).

18.10 SAP Integration

The SAP integration enables the following scenarios:

e Linking HR master data in SAP with the respective personnel files

e Storing payslips generated with SAP in the respective personnel files
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e Export of the organizational structure from SAP and import to the Fabasoft Personnel File

18.10.1 Linking HR Master Data

The integration for linking HR master data is carried out with an own information type 9600
“Fabasoft Personnel File” (/raBasorT/ name space). Therefore, no direct modifications in SAP are
required and update-safety is ensured.

Setting up the SAP integration is divided into the following three steps:

¢ Importing certificates
e Importing transport requests

¢ Configuration

18.10.1.1 Importing Certificates

For communication with the Fabasoft Personnel File, the corresponding CA certificates must be
stored with the SAP SSL Server.

To import the CA certificates, perform the following steps:

1. Navigate in your web browser to the Fabasoft Personnel File.

2. You can view the certificate hierarchy via the address bar of the web browser.

p | Certificate >

General Details Certification Path

Certification path

55l SwissSign
~-{2p] SwissSign EV Gold CA 2014 - G22

--[5] idp.doud. fabasoft.com

3. Save all CA certificates of the hierarchy to a file. In the following, these certificates are imported
into SAP.
Note: In the case of the Fabasoft Cloud save both SwissSign CA certificates.

Switch to the SAP GUI.
Run the STRUST transaction.
If no “SSL Server Standard” is configured, create one with the “Create” context menu command.

Switch to edit mode.

© N o ok

In the Certificate field, you can import a CA certificate with the “Import Certificate” button and
add it to the trusted certificates with the “Add to Certificate List” button. Repeat this step for all
CA certificates of the Fabasoft Personnel File certificate hierarchy.

9. Save the changes.

18.10.1.2 Importing Transport Requests

The linking of HR master data requires two transfer requests, which can be downloaded here:

Transport Requests (Fabasoft Personnel File - SAP Integration): Linking HR Master Data
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Pass the files to your SAP administrator, who can use the STMS transaction (Transport
Management System) to import the transport requests and forward them, according to your
compliance rules, to your production system.

Note: Before importing, make sure that the information type 9600 is not already used in your
system. If this is the case, please contact the Fabasoft Support.

18.10.1.3 Configuration

After a successful execution of the transport requests, you need to configure the URLs of the
Fabasoft Personnel File in SAP.

To carry out the configuration in SAP, perform the following steps:

1. Switch to the SAP GUI.
2. Run the SM30 transaction.
3. Inthe Table/View field enter “/FABASOFT/PERSF” and click “Display”.
4. Switch to edit mode.
5. Define the following values:
URL PERSFILE folio/personnelfie/
URL PROTOCOL https://
URL WEBSRVC folio/ fscdav/wsd?WEBSYC=FSCPERSONMELFILE_1_1001_WebServicesPersonnell
URL WEBSRVC DOMAIN at.cloud. fabasoft.com/

O PERSFILE
By default (valid for the Fabasoft Cloud):

folio/personnelfile/
If you use the personnel file in the Fabasoft Private Cloud, replace folio with cloud.

O WEBSRVC

By default (valid for the Fabasoft Cloud):
folio/fscdav/wsdl?WEBSVC=FSCPERSONNELFILE 1 1001 WebServicesPersonnelFile

If you use the personnel file in the Fabasoft Private Cloud, replace folio with cloud.

O WEBSRVC DOMAIN

By default (valid for the Fabasoft Cloud, location Austria):
at.cloud.fabasoft.com/

If you use the personnel file in a different location or in the Fabasoft Private Cloud, enter the
appropriate URL.

6. Save the changes.

Note: If you have also imported the transport request for storing payslips, additional configuration
settings are available that are not used in this scenario.

18.10.2 Storing Payslips

SAP-generated payslips can be automatically stored in the respective personnel file.
Setting up the SAP integration is divided into the following four steps:

¢ Importing Certificates
e Activating HR Forms
e Importing Transport Requests

e Configuration
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18.10.2.1 Importing Certificates

For communication with the Fabasoft Personnel File the corresponding CA certificates must be
stored with the SAP SSL Server. If you have not yet done so, perform the steps described in chapter
18.10.1.1 “Importing Certificates”.

18.10.2.2 Activating HR Forms
Make sure that the HR form you are using for payslips is activated. For technical reasons, the HR
form sap_paysLIP AT must also be activated.
To activate an HR form, perform the following steps:
1. Switch to the SAP GUI.
2. Run the HRFORMS transaction.
3. Open the “Utilities” menu and execute the "Activate Forms" command.
4. Select the desired HR form.
5. Select the “Generate structure and program” option.
6. Click “Execute”.
Note:
e The HR forms must be activated before the transfer request for storing payslips is imported.

¢ The activation must be carried out on all systems on the transport path on which the HR forms
are tested or used.

18.10.2.3 Importing Transport Requests

It is required that the two transport requests for linking HR master data have been imported (see
chapter 18.10.1.2 “Importing Transport Requests”).

In addition, the transport request for storing payslips must be imported. This transport request can
be downloaded here:

Transport Requests (Fabasoft Personnel File - SAP Integration): Storing Payslips

18.10.2.4 Configuration

Once the transfer requests have been successfully executed, the report
/FABASOFT/VDN2RECM INIT must be executed once on the respective systems. In the Form field,
enter the HR form you are using for the payslips and execute the report.

Note: If you want to use a different HR form, the initialization report must be executed again.
Finally, you must perform the following configuration steps:

Switch to the SAP GUI.

Run the SM30 transaction.

In the Table/View field enter “/FABASOFT/PERSF" and click “Display”.

Switch to edit mode.

s N

Define the following values:
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O PERSFILE
By default (valid for the Fabasoft Cloud):

folio/personnelfile/

If you use the personnel file in the Fabasoft Private Cloud, replace folio with cloud.
0 VDNDOCTYPE

Defines the external key of the category that should be assigned to the payslip.
O VDNFILE

By default (valid for the Fabasoft Cloud):
folio/uploadpfdocument/

If you use the personnel file in the Fabasoft Private Cloud, replace folio with cloud.
0 VDNPFREGISTER

Defines the external key of the personnel file folder in which the payslip should be stored.
o VDNSTATUS

Defines the document state: PersonnelFileDocumentInProgress OF
PersonnelFileDocumentClosed

O WEBSRVC

By default (valid for the Fabasoft Cloud):
folio/fscdav/wsdl?WEBSVC=FSCPERSONNELFILE 1 1001 WebServicesPersonnelFile

If you use the personnel file in the Fabasoft Private Cloud, replace folio with cloud.
O WEBSRVC_ DOMAIN

By default (valid for the Fabasoft Cloud, location Austria):
at.cloud.fabasoft.com/

If you use the personnel file in a different location or in the Fabasoft Private Cloud, enter the
appropriate URL.

6. Save the changes.

18.10.3 Export and Import of the Organizational Structure

A CSV file describing the organizational structure can be generated from the organizational chart
and employee master data available in SAP. The organizational structure can be transferred using
the import mechanism of the Fabasoft Personnel File.

18.10.3.1 Importing the Transport Request

The transport request needed for exporting the organizational structure can be downloaded here:

Transport Requests (Fabasoft Personnel File - SAP Integration): Exporting Organizational
Structure

Pass the files to your SAP administrator, who can use the STMS transaction (Transport
Management System) to import the transport requests and forward them, according to your
compliance rules, to your production system.

19 Interfaces

The Fabasoft Personnel File provides following interfaces for the communication with third-party
products.

19.1 URLs

The following friendly URLs are available.
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Presenting a Personnel File
To present a personnel file, for example, in a web browser you can use the following URLs:

Access based on the personnel number

https://<server>/<vdir>/fscasp/content/bin/fscvext.dl1?ax=C00.1.1001.1.396257
&shelfid=<Fabasoft Cloud ID or Import ID of the personnel file shelf>
&persnum="'<personnel number>"'

https://<server>/<vdir>/personnelfile/<personnel number>/<Fabasoft Cloud ID of
the personnel file shelf>

Parameters:

e shelfid
Fabasoft Cloud ID of the personnel file shelf.

® persnum
Personnel number of the personnel file to be opened.

https://at.cloud. fabasoft.com/folio/fscasp/content/bin/fscvext.dl1?ax=C00.1.1001
.1.396257&shelfid=C00.1.3285.3.19&persnum="'00001"

https://at.cloud. fabasoft.com/folio/personnelfile/00001/C00.1.3285.3.19

Access based on the user ID

https://<server>/<vdir>/fscasp/content/bin/fscvext.dl1?ax=C00.1.1001.1.396256
&shelfid=<Fabasoft Cloud ID or Import ID of the personnel file shelf>
&userid=<Fabasoft Cloud ID or e-mail address of the assigned user>

https://<server>/<vdir>/personnelfile/
Note: Personnel file of the currently logged in user.

https://<server>/<vdir>/personnelfile/<Fabasoft Cloud ID or e-mail address of
the assigned user>/<Fabasoft Cloud ID of the personnel file shelf>

Parameters:

e shelfid
Fabasoft Cloud ID of the personnel file shelf.

® userid
Fabasoft Cloud ID of the user who is assigned to the personnel file. If the userid is not defined,
the system tries to identify a personnel file that is assigned to the currently logged in user.

https://at.cloud. fabasoft.com/folio/fscasp/content/bin/fscvext.dl1?ax=C00.1.1001
.1.396256

Note: Personnel file of the currently logged in user.

https://at.cloud. fabasoft.com/folio/fscasp/content/bin/fscvext.dl1?ax=C00.1.1001
.1.396256&shelfid=C00.1.3285.3.19
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https://at.cloud. fabasoft.com/folio/fscasp/content/bin/fscvext.dl1?ax=C00.1.1001
.1.396256&shelfid=C00.1.3285.3.196userid=cadence.jones@fabasoft.com

https://at.cloud. fabasoft.com/folio/fscasp/content/bin/fscvext.dl1?ax=C00.1.1001
.1.396256&shelfid=C00.1.3285.3.19&userid=C00.1.3285.1.15

https://at.cloud.fabasoft.com/folio/personnelfile/
Note: Personnel file of the currently logged in user.

https://at.cloud. fabasoft.com/folio/personnelfile/cadence.jones@fabasoft.com/CO0O
.1.3285.3.19

Uploading a Document

To upload a document in a personnel file you can use following URL:

Syntax

https://<server>/<vdir>/uploadpfdocument/<personnel number>/<Fabasoft Cloud ID
of the personnel file shelf>/<document name with file extension>/<external key
of the category>/<external key of the personnel file folder>/<valid from: yyyy-
mm-dd>/<valid until: yyyy-mm-dd>/<document state:
PersonnelFileDocumentInProgress oder PersonnelFileDocumentClosed>

The document must be delivered in the HTTP body. The parameters “personnel number”,
“document name with file extension” and the content of the document are mandatory. If no
personnel file folder but a category is defined, it is tried to determine the personnel file folder via
the category. If no unambiguous personnel file folder can be determined, an error is generated.

https://at.cloud. fabasoft.com/folio/uploadpfdocument/00002/doc.txt//HRDOCUMENT P
AYROLL//2017-01-30/

19.2 Web Service

A web service is provided to upload documents and to create or read personnel files.

The WSDL can be accessed using the following URL:

https://<server>/<vdir>/fscdav/wsdl?WEBSVC=FSCPERSONNELFILE 1 1001 WebServicesPers
onnelFile

The web service supports also the JSON format:
https://<host>/<vdir>/wsjson/FSCPERSONNELFILE 1 1001 WebServicesPersonnelFile/<ope
ration>

Operations:

® GetPersonnelFile
Retrieves a list of personnel files based on a personal number. If no personnel files can be

found a list of available personnel file shelves are returned.

® CreatePersonnelFile
Is used to create a personnel file with the given property values.

® UpdatePersonnelFile
Refreshes a personnel file. Single-valued properties are overwritten if they are specified. To
remove a value from a single-valued property, the property must not be specified and be
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defined in overwriteattributes. Values of multi-valued properties are appended by default. If
they are defined in overwriteattributes they are overwritten. You can use
implicitcreateonupdate to specify whether a personnel file should be created, if no
personnel file with the specified combination of persnum and shelfid exists.

If it is defined in the personnel file configuration that unique personnel numbers should be
used across all personnel file shelves, existing personnel files can be moved by specifying a
different shelfid.

® UploadDocument
Is used to upload documents to a personnel file.

® UploadScannedDocument
Is used to upload scanned documents to the personnel file. To do so the personnel file shelf
and the barcode have to be submitted as parameter. The document is automatically removed
from the scan queue after a successful upload.

Request JSON (GetPersonnelFile):

{"shelfid":"C00.200.200.4.156", "persnum":"00000008"}
{"shelfid":null, "persnum":"00000000"}

Request JSON (CreatePersonnelFile):

{
"data": {
" ": "PersonnelFileData",
"shelfid": "C00.200.200.4.156",
"persnum": "10000001",
"firstname": "Martin",
"surname": "Peterson",
"socialsecid": "12345",
"sex": "1",
"supervisorid": "colin.steve@example.com",
"allsupervisors": [
{"supervisorid": "laura.hammond@example.com"},
{"supervisorid": "davis.baker@example.com"}

Request JSON (UpdatePersonnelFile):

{
"data": {
" ": "PersonnelFileData",
"shelfid": "C00.200.200.4.156",

"persnum": "10000001",

"telephone": [ {
" ": "Telephone",
"telnumber": "+43 664 12345"
1
"supervisorid": "laura.hammond@example.com",
"allsupervisors": [
{"supervisorid": "laura.hammond@example.com"},
{"supervisorid": "davis.baker@example.com"}

] r

"overwriteattributes": [
"telephone",
"supervisorid",
"allsupervisors"
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Request JSON (UploadDocument):

{

"persnum" "oooo1",
"shelfid" "C00.1.506.4.3628",
"docname" "Payroll 2017 12.txt",
"doctype" "HRDOCUMENT PAYROLL",
"register" "HRREGISTER PAYROLL",
"validfrom" "2017-01-02",
"validuntil” "2017-12-15",
"docstate" "PersonnelFileDocumentClosed",
"doccontent" "RG9rdwWllbnRpbmhhbHQ",
"params" : {
"objsubject" : "Payroll",
"COOSYSTEM@1.1l:objexternalkey" : "extid",
"FSCTERM@1.1001:0bjterms" : ["C00.1.506.4.19119",

}

"C00.1.506.4.19120"]

More information about the parameters of the operations can be found here:
https://help.appducx.fabasoft.com/index.php. Search for the corresponding actions

(WSGetPersonnelFile, WSCreatePersonnelFile, WSUpdatePersonnelFile,

WSUploadDocument, UploadScannedDocument).
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